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introduction

welcoMe
This training guide was written with you in mind – our user. Since the late 1980s MICRO‑AIDE has been 
designing and manufacturing Event Recorders for the Rail Signal Industry. Our recorders have been 
praised for their ease‑of‑use, utility and durability. Over the years we have also strived to provide you with 
comprehensive documentation. This guide’s objective is to explain, step‑by‑step, how to perform one 
important recorder task at a time. We think you’ll find this guide indispensable when working with our 
recorders.

the Metra recording SySteMS
Metra has defined requirements for two recording systems referred to as the 2‑Track and 4‑Track 
Recording Systems. Briefly stated, each system comprises an Event Recorder, a light out detector device 
and related PC software.

The 2‑Track and 4‑Track Recording Systems utilize the MICRO‑AIDE CWR‑40E and CWR‑72E Event 
Recorders, respectively. The two recorders vary in only one regard. The CWR‑40E is equipped with 32 
Digital Inputs, the CWR‑72E is equipped with 64. In all other aspects the two products are identical. They 
are both installed with and execute the same firmware.

MICRO‑AIDE’s Failed Lamp Detector (FLD‑2) serves as the light out detector in both recording systems. 
Our Graphical Event Analyzer (GEA) software can be installed on any Windows® PC. It provides a conve‑
nient GUI‑based interface for viewing and plotting data acquired from either recording system.

about thiS guide
At the request of Metra, MICRO‑AIDE has prepared two Training Guides. This copy is referred to as the 
Technician’s Version. It has been written to provide instructions primarily for technicians and maintain‑
ers who must be able to use the recording systems primarily for the purpose of capturing and reviewing 
Event Record data. An example would include getting and saving to a PC file, event data related to 
a crossing incident. The same could be true of maintenance or performance data. In either case, the 
recording system has been previously set up and is now fully operational.

The Engineer’s Version includes all of the instructions listed in the Technician’s Version, but is written pri‑
marily for signal engineers and staff responsible for the setup and configuring of the CWR‑40E, CWR‑72E 
and FLD‑2. It is much more comprehensive as it provides detailed instructions on how a variety of param‑
eters are assigned.

The “Table of Contents” provides a concise overview of the contents of each version. In the prepara‑
tion of this guide, data was captured from an actual CWR‑40E or CWR‑72E recorder. Version 1.02 of the 
firmware was used along with the Setup Databases approved by Metra in January of 2011.

taSkS
Both versions of the Training Guide contain individual blocks of instruction referred to as tasks. One task 
may include instructions on how to assign a site ID. Another task may provide details on how to capture 
Event Records to a PC file. In all cases, tasks are devoted to a particular activity that you will likely need 
to perform in the future.
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All instruction guides have a starting point. This one is no different. Task 1 entitled “Creating a 
HyperTerminal Serial Connection” and Task 3 entitled “Getting to the Main Menu Using the Terminal 
Port” are key and must be understood and performed before you can proceed further. After that you 
are free to perform any task in any order that best suits your needs. However, the sequence of tasks listed 
in the guide is intentional. For the most part they are listed in a sequence consistent with normal use of 
the recorder; that is, the steps you would most likely take when using a recorder for the first time.

what thiS guide aSSuMeS
You can access your recorder via several methods. Accessing a recorder can be accomplished via the 
front panel LCD and keypad, USB Device Port, internal modem or serial Terminal Port. This guide starts off 
by offering basic instructions on how to access the recorder via a Terminal Port. This is the most common 
method used to dialog with a recorder. Other tasks describe the use of the modem and USB Device Port. 
It is further assumed that you will be using a Windows‑based PC and that HyperTerminal® is installed and 
available for use as the required communications application. Windows 7® was used throughout the 
preparation of this guide. Your operating system may differ, but the differences will not be significant.

conVentionS
This guide uses several typographic and reference conventions to clarify what you must select, enter or 
type. Each are described in the following sections.

labelS within windowS
This guide shows you how to perform several tasks that rely upon your ability to exercise Windows‑related 
commands. “Connect using” is an example of a command, field or tab that can be found within 
Windows. A Windows‑related label will always be enclosed in quotes.

what you MuSt tyPe
By way of example, many of the tasks include cases where you must enter a parameter. SIGNAL illus‑
trates the style of font used for this purpose. The user should assume that the letter‑case shown must be 
used.

PreSSing a SPecific key
In some cases a specific key on the keyboard of the PC must be pressed. Enter and Esc illustrate this 
convention. Your recorder is equipped with a front‑panel‑mounted keypad that comprises 20 pushbut‑
ton switches. Each pushbutton is identified with an appropriate silkscreened label. Browse and Enter 
illustrate the italic style used to identify these keys.

recorder labelS and referenceS
The recorder includes many of its own labels. A specific menu, command, field or setting must be prop‑
erly identified. A normal font with appropriate first letter capitalization is used for this purpose. Main Menu 
illustrates this convention.

identifying Sub‑coMMandS
The recorder implements numerous commands and sub‑commands. As has been previously described, 
a normal font and first letter capitalization is used to identify recorder commands (e.g., Setup). Sub‑
commands include an intermediate right‑angle bracket character (e.g., Setup > System Parameters).

linkS
Like all MICRO‑AIDE prepared user documentation, this manual is available for downloading as a PDF 
document at our website. The PDF version includes numerous click‑able links. An example of a link is: “The 
Metra Recording Systems” on page ix.
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cwr‑40e and cwr‑72e uSage
Finally, the CWR‑40E and CWR‑72E Event Recorders are identical in all aspects except one. The former is 
equipped with 32 Digital Inputs, the latter with 64. Throughout this Training Guide the terms recorder(s), 
Event Recorder(s) and CWR‑72E are intended to refer to either product. The term CWR‑40E is used only in 
those rare cases where a distinction must be made.

SetuP databaSeS
All MICRO‑AIDE Event Recorders include a user‑defined Setup Database. Each Setup Database must be 
unique to each recorder. A Setup Database can be thought of as a collection of various names, labels 
and settings that add clarity to the Event Records and various reports issued by the recorder. Setup 
Databases are saved in the non‑volatile memory of the recorder.

Metra has prepared and approved three different Setup Databases for use with the recorders. A brief 
description of their use follows.

Mainline – This database is used exclusively with CWR‑72E Event Recorders.

BEV� – This database is used exclusively with CWR‑40E Event Recorders. It features East/West labeling.

MED� – This database is used exclusively with CWR‑40E Event Recorders. It features North/South labeling.

Every Event Recorder shipped to Metra will have pre‑installed an appropriate Setup Database. The 
shipping container will clearly identify the recorder type. All three Setup Databases are fully detailed in 
Appendix B of the CWR‑40E/CWR‑72E Event Recorder User Manual. A PDF copy of the manual can be 
downloaded from the MICRO‑AIDE website at: 
www.micro‑aide.com/support/documentation.html

acceSS control and Security
Each Event Recorder includes several access points (e.g., Terminal Port, front panel keypad, etc.) by 
which a user can interact with the recorder. However, irrespective of the access point each user must 
log onto the recorder by first honoring a password or the Passcode. There are no exceptions to this rule. 
There are two levels of access that are employed by the Terminal Port, modem and USB Device Port. 
Both levels of access control and the Passcode are described in the following.

adMiniStratiVe acceSS
The Administrative Password allows the user full access and control of the recorder. Accordingly, its use 
must be guarded. Its assigned value will not be revealed anywhere in this Training Guide. The Engineer’s 
version of the Training Guide explains Administrative and Restricted Access commands and features. The 
Administrative Password is used by the Terminal Port, modem and USB Device Port.

reStricted acceSS
The Restricted Password allows the user only limited access and control of the recorder. Irrespective of 
the Setup Database employed, the Restricted Password is SIGNAL. Passwords are always case‑sensitive. 
The Administrative Password is used by the Terminal Port, modem and USB Device Port.

PaSScode
The correct Passcode must be entered to gain access via the front panel keypad. Irrespective of the 
Setup Database employed, the Passcode is 547.

http://www.micro-aide.com/support/documentation.html
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if you need helP
If at any time you need help, we encourage you to contact us. We can be reached as follows:

Micro‑Aide corporAtion 
685 Arrow Grand Circle 

Covina, CA 91722 
Tel: 626‑915‑5502     Fax: 626‑331‑9484 

E‑mail: support@micro‑aide.com

If you believe this Training Guide can be improved by the inclusion of an additional task(s), don’t hesitate 
to inform us. Our objective is to make this document useful, and you know best how that can be accom‑
plished.

mailto:support%40micro-aide.com?subject=Metra%20Support%20Request
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how to . . .

Task 
1

PrePare a Pc Serial connection

creating a hyPerterMinal Serial connection
The CWR‑72E Event Recorder is equipped with one Terminal Port. Unless otherwise stated, this guide as‑
sumes that you will be accessing your recorder via a Terminal Port and that a PC running HyperTerminal 
will be used to facilitate the required connection.

before you Start
Your PC must have HyperTerminal installed and ready for use. You should be familiar with the steps nec‑
essary to launch your Windows operating system and log on as a user. You should also be familiar with 
basic Windows operations, such as selecting commands and using the mouse.

what to do
We’ll begin by creating a new connection specifically for your CWR recorder. We’ll then set the Baud 
rate, bit coding and terminal emulation for the connection. Perform the steps listed in each section in the 
order given.

creating a new Serial connection
1. Using your mouse, click in the lower left‑hand corner of your desktop in the area labeled “Start”. Then 

click in the area labeled “All Programs”.

2. Click on the folder labeled “HyperTerminal” to expand it.

3. Click the sub‑list item labeled “HyperTerminal”. After a short delay the following dialog box labeled 
“Connection Description” will appear.

 HyperTerminal – New Connection Dialog Box

4. In the edit box labeled “Name:” enter a label that identifies the new connection. As an example, 
type CWR Recorder. Click the button labeled “OK”. The following dialog box named “Connect To” 
will appear.
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 HyperTerminal – Connect To Dialog Box

5. Click the down arrow at the right edge of the drop‑down list box labeled “Connect using:”. Select an 
available comm port such as “Com1”, “Com2”, “Com5”, etc.

6. Click the button labeled “OK” to accept the new comm port assignment.

A new HyperTerminal connection has been created. It is now necessary to assign the correct Baud rate, 
bit coding and emulation for the connection.

Setting the baud rate, bit coding and eMulation
After selecting the comm port for the new connection the dialog box named “Com Properties” will be 
displayed. An example is shown in the following. Your dialog box will actually be labeled with the comm 
port number you selected earlier.

The default Baud rate setting for all CWR recorders is 38,400. This setting will work unless it was previously 
altered. The bit coding must be set as shown in the following. It must not be altered. The setting is referred 
to as 8‑N‑1.

7. Set the five fields as they are shown in the following.

 HyperTerminal – Com Properties Dialog Box
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8. Click the button labeled “OK”. A blank HyperTerminal window will appear.

9. Click on the command named “File”. It is located in the menu bar at the top of the HyperTerminal 
window. Click on the sub‑command named “Properties”. A dialog box labeled “CWR Recorder 
Properties” will be displayed.

10. At the top of the dialog box click the tab labeled “Settings”. A dialog box similar to the following will 
be displayed.

HyperTerminal – Com Properties Dialog Box

11. Modify the various settings to match those listed in the previous screen. Make sure that the drop‑
down list box labeled “Emulation:” is set to “ANSI”.

12. Double check everything. If all the settings are correct click the button labeled “OK”.

13. The menu bar is located along the top of the HyperTerminal window. Click the command named 
“File” and then the sub‑command named “Save”.

Your PC now has a newly defined comm port connection that is tailored for your CWR recorder. You 
can also use it to access your other CWR recorders. To launch the new connection simply click the icon 
labeled “CWR Recorder.ht” that exists within the HyperTerminal Connections folder.

For easy access, you may wish to create a shortcut for the “CWR Recorder” connection and place it on 
your Windows desktop.
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Task 
2

PrePare a Pc ModeM connection

creating a hyPerterMinal ModeM connection
Every CWR‑72E Event Recorder used by Metra is also equipped with an internal 33,600 Baud modem. Like 
the Terminal Port, it can be used to access your recorder via any PC equipped with HyperTerminal and 
a modem. Unlike the Terminal Port, the modem allows you to establish a remote connection to various 
recorders.

before you Start
Your PC must have HyperTerminal installed and ready for use. You should be familiar with the steps nec‑
essary to launch your Windows operating system and log on as a user. You should also be familiar with 
basic Windows operations, such as selecting commands and using the mouse. A further requirement is 
that the PC have access to a modem. It is assumed that the modem is internal to the PC.

what to do
We’ll begin by creating a modem‑based connection for a specific recorder. A unique telephone num‑
ber will identify a recorder. Perform the steps listed in each section in the order given.

Each recorder is accessible via a unique phone number. Accordingly, the steps detailed in this task must 
be repeated for each recorder of interest to the user.

creating a new ModeM connection
1. Using your mouse, click in the lower left‑hand corner of your desktop in the area labeled “Start”. Then 

click in the area labeled “All Programs”.

2. Click on the folder labeled “HyperTerminal” to expand it.

3. Click the sub‑list item labeled “HyperTerminal”. After a short delay the following dialog box labeled 
“Connection Description” will appear.

HyperTerminal – New Connection Dialog Box
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4. In the edit box labeled “Name:” enter a label that identifies the new connection. As an example, 
type D�undee Recorder. Click the button labeled “OK”. The following dialog box named “Connect 
To” will appear.

HyperTerminal – Connect To Dialog Box

5. Click the down arrow at the right edge of the drop‑down list box labeled “Connect using:”. Select 
the internal modem (e.g.,  “USB Modem”). Enable the check boxes labeled “Detect Carrier Loss” and 
“Use country/region code and area code” settings as shown in the previous screen.

6. In the edit box labeled “Area code:”, enter the area code portion of the phone number associated 
with the telephone line connected to the recorder. In the edit box labeled “Phone number:”, enter 
the remaining seven digits of the phone number.

7. Click the button labeled “Configure...”. A dialog box similar to the following will be displayed.

HyperTerminal – Modem Preferences Dialog Box

8. As shown in the previous screen, in the drop‑down list box labeled “Data Protocol:” select the 
“Forced EC” setting. For the drop‑down list box labeled “Compression:” select the “Enabled” setting. 
For the drop‑down list box labeled “Flow control:” select the “Hardware” setting. Finally, click the but‑
ton labeled “OK”.
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9. The “Connect To” dialog box depicted in step 4 will be displayed. Click the button labeled “OK”. The 
following dialog box will be displayed.

HyperTerminal – Connect Dialog Box

10. Verify the displayed settings and change them as necessary. If they are correct click the button 
labeled “Cancel”. A blank HyperTerminal window will be displayed.

aSSigning the eMulation SettingS
11. Click the “File > properties” command located in the menu bar at the top of the HyperTerminal win‑

dow. A dialog box named “Dundee Recorder Properties” will be displayed.

12. At the top of the dialog box click the tab labeled “Settings”. A dialog box similar to the following will 
be displayed.

HyperTerminal – Properties Dialog Box

13. Modify the various settings to match those listed in the previous screen. Make sure that the drop‑
down list box labeled “Emulation:” is set to “ANSI”.

14. Double check everything. If all the settings are correct click the button labeled “OK”.

15. The menu bar is located along the top of the HyperTerminal window. Click the command named 
“File” and then the sub‑command named “Save”.

Your PC now has a newly defined modem connection that is tailored for your CWR recorder. To 
launch the new connection simply click the icon labeled “Dundee Recorder.ht” that exists within the 
HyperTerminal Connections folder.
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For easy access, you may wish to create a shortcut for the new modem connection and place it on your 
Windows desktop.
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Task 
3

log on Via a Serial connection

getting to the Main Menu uSing the terMinal 
Port

Regardless of the access point employed, all CWR recorders utilize two levels of access security. Before 
you are allowed to access the recorder you must enter a valid password. Which password is entered 
determines the level of access you are granted.

before you Start
This task assumes that you will be connecting a PC running HyperTerminal to a Terminal Port of the re‑
corder. It is further assumed that the HyperTerminal connection named “CWR Recorder” established in 
Task 1 entitled “Creating a HyperTerminal Serial Connection” is available.

Terminal Ports for all CWR recorders utilize a nine‑pin DE‑9 male connector. Each port is compliant with 
the RS‑232 serial interface standard. Your recorder was shipped with an RS‑232 cable suitable for use with 
the serial comm port of a PC. The cable is wired one‑to‑one, that is pin 1 connects to pin 1, 2 to 2, etc. If 
your PC is not equipped with a serial comm port you will have to use a USB‑to‑serial cable adapter. These 
adapters are available at most computer retail stores.

Do not attempt to use a null modem cable. 
 
To improve the ground isolation properties of the recorder, the MICRO‑AIDE supplied cable has the shield 
wire disconnected. Only use the MICRO‑AIDE supplied cable.

what to do
If you haven’t already done so, turn power on to your PC and launch Windows. After you have logged 
on to your PC, launch the HyperTerminal connection named “CWR Recorder”. Perform the steps as listed 
in the following and in the order given.

1. Connect the MICRO‑AIDE supplied RS‑232 cable to the PC comm port selected for use by the 
HyperTerminal connection named “CWR Recorder”. This connection may need to be made via a 
USB serial adapter.

2. Connect the other end of the RS‑232 cable to the Terminal Port of the recorder.

3. Apply power to the recorder. After a brief delay a message similar to the following will appear in your 
HyperTerminal window.

Escape to Boot Loader

Micro-Aide CWR-72E Flash Boot Loader 1.01
Press ESC for boot loader

4. Ignore the message concerning the Esc key. After five seconds a password challenge similar to the 
following will be displayed.
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Model CWR-72E Metra Event Recorder. Ver 1.02 (C) 2011 MICRO-AIDE INC.

***** NOT SET *****

Event storage capacity: 111481

Enter password:

Password Challenge

5. Enter the Administrative or Restricted Password. Complete the entry by pressing the Enter key. You 
are now logged on to the recorder. The Main Menu as shown in the following will be displayed.

                        MICRO-AIDE CWR-72E Event Recorder

                                 S Setup
                                 L Live Status
                                 Q Query Events
                                 V View Events
                                 M Measure Flash Rate
                                 T Transfer Files
                                 D Diagnostics
                                 X Log Off

Main Menu

The Restricted Password has been defined by Metra as SIGNAL. For security reasons, the Administrative 
Password will not be identified anywhere in this guide.

Congratulations. Using your previously defined HyperTerminal connection, you can now exercise the 
capabilities of your recorder. Remember, the Main Menu is always your initial launching point.

related featureS

default PaSSwordS
Your CWR recorder utilizes two levels of password security that are applicable to the Terminal Port, USB 
Device Port and internal modem. The Administrative Password allows you to access all recorder features 
and functions. It allows you to alter the Setup Database of the recorder. The Restricted Password allows 
you unlimited access to viewing and retrieval of data from the recorder. However, it provides for only 
limited alteration of the Setup Database.

By Metra request, the Administrative Password will not be documented within this guide. The preassigned 
Restricted Password is SIGNAL. Passwords are case‑sensitive.

logging on uSing a ModeM
Logging on to the recorder via a modem connection is described in Task 4.

naVigating and Selecting coMMandS
The emulation setting of your HyperTerminal connection is set to “ANSI”. This setting allows you to highlight 
a specific recorder command or field by simply pressing the up and down arrow keys at the keyboard of 
your PC. After the highlight is positioned properly, press the Enter key to select the command.

logging off
When you have completed your session with the recorder you should get in the habit of logging off. 
There are two ways to perform a log off. From the Main Menu you can press the X key at your keyboard. 
Highlight the Yes option and then press the Enter key to log off. Alternatively, you can simply disconnect 
the cable attached to the Terminal Port. In either case, the next user will have to enter a valid password 
to access the recorder.
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Task 
4

log on Via a ModeM connection

getting to the Main Menu uSing a ModeM
Regardless of the access point employed, all CWR recorders utilize two levels of access security. Before 
you are allowed to access the recorder you must enter a valid password. Which password is entered 
determines the level of access you are granted.

before you Start
This task assumes that you will attempt to log on to the recorder via a remote modem connection. It is 
further assumed that the modem connection will be established via a PC running HyperTerminal. The mo‑
dem connection named “Dundee Recorder” described in Task 2 entitled “Creating a HyperTerminal 
Modem Connection” will be used as an example throughout this task.

what to do
Verify the modems at both ends are connected to functioning phone lines. If you haven’t already done 
so, turn power on to your recorder and PC. Launch Windows and log on to your PC. Perform the steps as 
listed in the following and in the order given.

1. Launch the modem connection named “Dundee Recorder”. After a short delay a blank 
HyperTerminal window and a dialog box similar to the following will be displayed.

HyperTerminal – Connect Dialog Box

2. Click the button labeled “Dial”. The PC’s modem will proceed to dial the number previously assigned. 
If the volume level of your PC has been turned up adequately you should be able to hear the dial 
tone, tone dialing, ring back and modem answer tone signals. The modems will then attempt to ne‑
gotiate a Baud rate appropriate for the phone line conditions.

3. Provided the sequence proceeds to a successful completion, a password challenge similar to the fol‑
lowing will be displayed. If the modems fail to connect you may wish to redial the connection.
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Model CWR-72E Metra Event Recorder. Ver 1.02 (C) 2011 MICRO-AIDE INC.

***** NOT SET *****

Event storage capacity: 111481

Enter password:

Password Challenge

4. Enter the Administrative or Restricted Password. Complete the entry by pressing the Enter key. You 
are now logged on to the recorder. The Main Menu as shown in the following will be displayed.

                        MICRO-AIDE CWR-72E Event Recorder

                                 S Setup
                                 L Live Status
                                 Q Query Events
                                 V View Events
                                 M Measure Flash Rate
                                 T Transfer Files
                                 D Diagnostics
                                 X Log Off

Main Menu

The Restricted Password has been defined by Metra as SIGNAL. For security reasons, the Administrative 
Password will not be identified anywhere in this guide.

Congratulations. Using your previously defined HyperTerminal modem connection, you can now exercise 
the capabilities of your recorder. Remember, the Main Menu is always your initial launching point.

related featureS

default PaSSwordS
Your CWR recorder utilizes two levels of password security that are applicable to the Terminal Port, USB 
Device Port and internal modem. The Administrative Password allows you to access all recorder features 
and functions. It allows you to alter the Setup Database of the recorder. The Restricted Password allows 
you unlimited access to viewing and retrieval of data from the recorder. However, it provides for only 
limited alteration of the Setup Database.

By Metra request, the Administrative Password will not be documented within this guide. The preassigned 
Restricted Password is SIGNAL. Passwords are case‑sensitive.

logging on uSing the terMinal Port
Logging on to the recorder via a serial RS‑232 connection is described in Task 3.

naVigating and Selecting coMMandS
The emulation setting of your HyperTerminal connection is set to “ANSI”. This setting allows you to highlight 
a specific recorder command or field by simply pressing the up and down arrow keys at the keyboard of 
your PC. After the highlight is positioned properly, press the Enter key to select the command.

logging off
When you have completed your session with the recorder you should get in the habit of logging off. 
There are two ways to perform a log off. From the Main Menu you can press the X key at your keyboard. 
Highlight the Yes option and then press the Enter key to log off. Alternatively, you can click the com‑
mand labeled “Call > Disconnect” located on the menu bar at the top of the HyperTerminal window. In 
either case, the phone line connection will be immediately terminated.
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Task 
5

identify the recording Site

aSSigning the unit naMe
The Unit Name serves a dual purpose. It can be used to distinguish different recorders. Additionally, it can 
be used to identify the site where the recorder is located. Including a DOT tag or milepost designation 
can be quite useful. The Unit Name is included at the top of every report.

The Unit Name setting can be altered in either an Administrative or Restricted Access session.

ruleS for creating a ProPer unit naMe
The recorder’s assigned Unit Name is a versatile piece of information. The full Unit Name is printed at 
the top of various reports. The first 20 characters of the Unit Name appear as the fourth line of text on 
the LCD while it is in Idle Mode. Refer to the illustration entitled “LCD During Idle Mode” on page 14. 
Additionally, the first 20 characters of the Unit Name are used to name the data folder created when 
saving Event Records to the USB flash drive. Refer to the Windows Explorer® screen entitled “Data Folder 
Saved to USB Flash Drive” on page 14.

Clearly, the first 20 characters of the Unit Name must be assigned carefully. Since these characters are 
used to form a folder name they must adhere to strict rules imposed by all Windows operating systems.

Various characters must not appear anywhere within the first 20 characters of the Unit Name. The 11 
prohibited characters are / \ ? % * : | “ < >. 
 
Additionally, a Space character must not appear as either the first or twentieth character in the Unit 
Name. For this reason it is best to use an underscore (i.e., _) in place of the Space character. 

Metra has defined a preferred composition for the Unit Name. An example of the definition is included  
towards the top of the screen entitled “System Parameters Command” on page 14. From left to right 
the Unit Name shall include the information listed in Table 1 as read from top to bottom.

Field Example Character Count

District Name DIST 1 to 4
Subdistrict Name _SUBDR 2 to 6
Crossing Name _XING‑NAME 2 to 10
DOT Number _DOT‑NUMBER As required
Mile Post Number _MILE‑POST‑NUMBER As required

Table 1: Unit Name Definition

The following rules also apply to the creation of the Metra‑defined Unit Name.

•	 The District, Subdistrict and Crossing Names must not exceed 20 characters in total.

•	 The Space character is not used for word separation. The underscore (i.e., _) and dash (i.e., -) char‑
acters are used instead for such purposes.

•	 The overall length of the Unit Name is limited to 80 characters.
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  TIME        DATE  
16:35:52*   09-11-11
CWR72E EventRecorder
DIST_SUBDR_XING-NAME

LCD During Idle Mode

Data Folder Saved to USB Flash Drive

before you Start
This task assumes you have already connected the recorder to a PC running HyperTerminal and you 
have logged on to the recorder with the Administrative Password. The first four tasks of this guide explain 
how to prepare your PC and the log on procedure. The Main Menu should be displayed.

what to do
From the Main Menu select the Setup > System Parameters command. A screen similar to the following 
will be displayed.

                               System Parameters
                               -----------------
                Unit Name
DIST_SUBDR_XING-NAME_DOT-NUMBER_MILE-POST-NUMBER
                Terminal Port Baud Rate  38400
                Administrative Password
                Restricted Password     SIGNAL
                Passcode                547
                Ring Count               2
                Primary Dial Number
                Secondary Dial Number
                Clock Sync Mode         GPS
                Clock Sync Input        ---
                Time Zone               CST  (UTC-6)
                Daylight Saving Time    Enabled
                High Temp Limit         257 Degrees F
                Low Temp Limit          -67 Degrees F
                Record Flash Details    Disabled

                             Ethernet is NOT installed

System Parameters Command

1. Locate the highlight in the Unit Name field. Press the Spacebar once to erase the existing name (e.g., 
***** NOT SET *****).

2. Type the new Unit Name as required, but subject to the limitations described in the section entitled 
“Rules for Creating a Proper Unit Name” on page 13.

3. To accept the new name either press the Enter key or move the highlight.

4. Press the Esc key twice to exit and return to the Main Menu.
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Task 
6

change the terMinal Port baud rate

aSSigning a different terMinal Port baud rate
Your recorder is equipped with a Terminal Port. The Terminal Port allows for serial communications, is 
RS‑232 based and utilizes a male DE‑9 connector. The Baud rate used by the Terminal Port can be as‑
signed using either of two procedures.

The Terminal Port Baud Rate setting can be altered in either an Administrative or Restricted Access ses‑
sion.

before you Start
This task assumes you have already connected the recorder to a PC running HyperTerminal and you 
have logged on to the recorder with the Administrative Password. The first four tasks of this guide explain 
how to prepare your PC and the log on procedure. The Main Menu should be displayed.

what to do

uSing a Pc and hyPerterMinal
From the Main Menu select the Setup > System Parameters command. A screen similar to the following 
will be displayed.

                               System Parameters
                               -----------------
                Unit Name
DIST_SUBDR_XING-NAME_DOT-NUMBER_MILE-POST-NUMBER
                Terminal Port Baud Rate  38400
                Administrative Password
                Restricted Password     SIGNAL
                Passcode                547
                Ring Count               2
                Primary Dial Number
                Secondary Dial Number
                Clock Sync Mode         GPS
                Clock Sync Input        ---
                Time Zone               CST  (UTC-6)
                Daylight Saving Time    Enabled
                High Temp Limit         257 Degrees F
                Low Temp Limit          -67 Degrees F
                Record Flash Details    Disabled

                             Ethernet is NOT installed

System Parameters Command

1. Move the highlight to the Terminal Port Baud Rate field.

2. Press the Spacebar repeatedly until the required Baud rate is displayed. The rate may be set to any 
of 10 values in the range from 300 to 115,200.

3. Press the Esc key twice to exit and return to the Main Menu. The following message will be displayed.
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                           Change baud rate now, then 
                            Press any key to continue

4. The Baud rate of your HyperTerminal connection must now be changed to accommodate the new 
setting. However, HyperTerminal will not allow you to change the Baud rate while a connection is 
active. Disconnect by clicking the command named “Call” located in the HyperTerminal menu bar. 
Click the sub‑command named “Disconnect”. You can no longer communicate with the recorder.

5. Change the Baud rate of your HyperTerminal connection in accordance with the procedure de‑
scribed in “Setting the Baud Rate, Bit Coding and Emulation” on page 2. The new setting must 
match the newly assigned Terminal Port Baud rate.

6. Click the HyperTerminal command named “Call” and then the sub‑command also named “Call”. 
After a short delay a new connection at the new Baud rate will be established. The password chal‑
lenge will be displayed.

froM the front Panel
Alternatively, perform the steps listed in the following section to assign a different Baud rate for the 
Terminal Port.

1. Press the Setup key. The following Passcode challenge will be displayed.

Enter the passcode:

Passcode Challenge

The Mainline, BEV and MED Setup Databases utilize the same Passcode. The Metra‑defined Passcode is 
547. It can only be entered using the numeric keys of the keypad.

2. Press the 547 keys and then the Enter key. The following information message will be displayed briefly.

Use ←→↑↓ to select 
items and then ENTER

3. The following abbreviated command menu will be displayed.

UName  Modem  Baud
Diag   Update

LCD Menu of Commands

By Metra decision, the accessible front panel commands are limited to those commands available to 
the user during a Restricted Access session.

4. Using the arrow keys, highlight the Baud command. Press the Enter key. The following collection of 
Baud rates will be displayed.
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Term baud rate:  300
   600   1200   2400
  4800   9600  19200
 38400  57600 115200

Baud Command

5. It is likely the 38,400 setting will be highlighted. To change the Baud rate use the arrow keys to relo‑
cate the highlight to the desired setting. Press the Enter key. The LCD menu of commands will be 
displayed. Press the Esc key to return to the Idle Mode.

6. The new rate will take effect immediately. The Baud rate used by the PC’s comm port must match 
the newly assigned Terminal Port rate. If it needs to be changed follow the steps listed in the section 
entitled “Setting the Baud Rate, Bit Coding and Emulation” on page 2.
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uSer noteS
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Task 
7

Set the ModeM anSwer delay

ModeM ring count
Your recorder is equipped with an internal 33,600 Baud internal modem. The Ring Count parameter 
determines the number of rings that must occur before the modem answers. This parameter can be as‑
signed using either of two procedures.

The Ring Count setting can be altered in either an Administrative or Restricted Access session.

before you Start
This task assumes you have already connected the recorder to a PC running HyperTerminal and you 
have logged on to the recorder with the Administrative Password. The first four tasks of this guide explain 
how to prepare your PC and the log on procedure. The Main Menu should be displayed.

what to do

uSing a Pc and hyPerterMinal
From the Main Menu select the Setup > System Parameters command. A screen similar to the following 
will be displayed.

                               System Parameters
                               -----------------
                Unit Name
DIST_SUBDR_XING-NAME_DOT-NUMBER_MILE-POST-NUMBER
                Terminal Port Baud Rate  38400
                Administrative Password
                Restricted Password     SIGNAL
                Passcode                547
                Ring Count               2
                Primary Dial Number
                Secondary Dial Number
                Clock Sync Mode         GPS
                Clock Sync Input        ---
                Time Zone               CST  (UTC-6)
                Daylight Saving Time    Enabled
                High Temp Limit         257 Degrees F
                Low Temp Limit          -67 Degrees F
                Record Flash Details    Disabled

                             Ethernet is NOT installed

System Parameters Command

1. Move the highlight to the Ring Count field.

2. The initial value for the Ring Count established in the Mainline, BEV and MED Setup Databases is 2. 
Enter a value ranging from 0 to 99.

A Ring Count value of 0 will prevent the modem from answering an incoming call. Use this value to dis‑
able the auto‑answer feature of the modem.
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3. To accept the new setting either press the Enter key or move the highlight.

4. Press the Esc key twice to exit and return to the Main Menu.

froM the front Panel
Alternatively, perform the steps listed in the following section to assign a different Ring Count for the 
modem.

1. Press the Setup key. The following Passcode challenge will be displayed.

Enter the passcode:

Passcode Challenge

The Mainline, BEV and MED Setup Databases utilize the same Passcode. The Metra‑defined Passcode is 
547. It can only be entered using the numeric keys of the keypad.

2. Press the 547 keys and then the Enter key. The following information message will be displayed briefly.

Use ←→↑↓ to select 
items and then ENTER

3. The following abbreviated command menu will be displayed.

UName  Modem  Baud
Diag   Update

LCD Command Menu

By Metra decision, the accessible front panel commands are limited to those commands available to 
the user during a Restricted Access session.

4. Using the arrow keys, highlight the Modem command. Press the Enter key. The current Ring Count 
setting will be highlighted as illustrated in the following.

Modem ring count: 2 
Prim/Sec Dial Number

Modem Command

5. The initial value for the Ring Count established in the Mainline, BEV and MED Setup Databases is 2. 
To change the current setting press the Enter key. Enter the new value by pressing the appropriate 
numeric keys. Leading zeros are not required. Enter a value ranging from 0 to 99.

A Ring Count value of 0 will prevent the modem from answering an incoming call. Use this value to dis‑
able the auto‑answer feature of the modem.

6. Accept the new value by pressing the Enter key. Press the Esc key twice to return to the Idle Mode.
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Task 
8

reView the configuration

Printing the SetuP databaSe
At any time while you are configuring your recorder you can easily and quickly review your assignments. 
This can be very helpful in verifying the accuracy and completeness of the configuration. The entire col‑
lection of Unit Name, Input Names, Detection Times, etc. is referred to as the Setup Database.

The Print Setup Data command is available to Administrative and Restricted Access sessions.

before you Start
This task assumes you have already connected the recorder to a PC running HyperTerminal and you 
have logged on to the recorder with the Administrative Password. The first four tasks of this guide explain 
how to prepare your PC and the log on procedure. The Main Menu should be displayed.

what to do
From the Main Menu select the Setup > Print Setup Data command. The following screen will be dis‑
played.

                                Print Setup Data

                           P Print All
                           E Print Event Names
                           I Print Input Names/Identifiers
                           D Print Detect Times/Flash Enable
                           A Print Analog Configuration
                           V Print Virtual Inputs
                           T Print Timer Configuration
                           M Print Measure Speed Parameters
                           N Print Network Settings
                           S Print System Parameters

Print Setup Data Command

Select any of the print options that best suit your inquiry. The Print All command allows you to review ev‑
ery setting in the Setup Database. The following sample data shows the end of a Print All report. It lists the 
system parameters for the Mainline Setup Database.
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Report printed on 09-11-11
DIST_SUBDR_XING-NAME_DOT-NUMBER_MILE-POST-NUMBER
Unit Name:
DIST_SUBDR_XING-NAME_DOT-NUMBER_MILE-POST-NUMBER
Terminal Port Baud Rate:         38400
Administrative Password: 
Restricted Password:     SIGNAL
Passcode:                547
Ring Count:              2
Primary Dial Number:
Secondary Dial Number:
Clock Sync Mode:         GPS
Clock Sync Input:        ---
Time Zone                CST  (UTC-6)
Daylight Saving Time     Enabled
High Temp Limit:         257 Degrees F
Low Temp Limit:          -67 Degrees F
Record Flash Details     Disabled
Report Done
hit any key to continue

End of Print All Report

At the completion of the report press any key to return to the Print Setup Data menu. Press the Esc key 
twice to exit and return to the Main Menu.

related featureS

Printing the SetuP databaSe
The on‑screen, readable version of the Setup Database can be captured as a .txt file using 
HyperTerminal. The procedure for doing so is described in the section entitled “Setting Up Capture 
Mode” on page 31. Once captured, the .txt file can be printed at any time.

PreaSSigned SetuP databaSeS
The Metra signal engineers have worked together with MICRO‑AIDE to develop three different databas‑
es. They are referred to as Mainline, BEV and MED. Table 2 details the use of each Setup Database.

D�atabase Name Used With

Mainline CWR‑72E
BEV CWR‑40E
MED CWR‑40E

Table 2: Setup Database Usage

All three Setup Databases are fully detailed in Appendix B of the CWR‑40E/CWR‑72E Event Recorder User 
Manual. A PDF copy of the manual can be downloaded from the MICRO‑AIDE website at: 
www.micro‑aide.com/support/documentation.html

http://www.micro-aide.com/support/documentation.html
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Task 
9

View eVent recordS

Query uSing the browSe oPtion
The Query Events command can be used to view Event Records at your PC monitor that have been pre‑
viously logged to memory. The command allows you to select a range of dates and times for the data 
that is of interest to you. Alternatively, Event Records can be viewed directly at the front panel’s LCD. 
A PC is not required using this method. In both cases several additional features control the range and 
content of the viewed records.

The Query Events command is available to Administrative and Restricted Access sessions.

before you Start
This task assumes you have already connected the recorder to a PC running HyperTerminal and you 
have logged on to the recorder with the Administrative Password. The first four tasks of this guide explain 
how to prepare your PC and the log on procedure. The Main Menu should be displayed.

To follow the examples cited in this task, your recorder must have Event Records logged to memory 
spanning two or more days.

what to do

uSing a Pc and hyPerterMinal
From the Main Menu select the Query Events command. A screen similar to the following will be dis‑
played.

Query Events Command – Table of Dates

                             Select Range of Dates

 08-25-11  08-26-11  08-27-11  08-28-11  08-29-11  08-30-11  08-31-11  09-01-11
 09-02-11  09-03-11  09-04-11  09-05-11  09-06-11  09-07-11  09-08-11  09-09-11
 09-10-11  09-11-11  09-12-11  09-13-11  09-14-11  09-15-11  09-16-11  09-17-11
 09-18-11  09-19-11  09-20-11

    Use arrow keys to move, Space=start selection, Enter=accept, ESC=cancel

In the previously cited sample data, 27 consecutive dates are displayed. As many as 128 dates can be 
listed. At least one Event Record was logged to memory for each date listed. The highlight will always be 
located at the first date position (e.g., 08‑25‑11). A two‑step process is required to view records. First, a 
date or range of dates must be selected. It is followed by selecting a range of times and report options.
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Selecting dateS

To select the date(s) perform either of the following procedures.

•	 To view records from a single date simply move the highlight to the desired date.

•	 To view records from two or more contiguous dates, move the highlight to the first date in the range. 
Press the Spacebar to anchor this position. Use the arrow keys to extend the highlight to encompass 
additional dates.

After the highlight has selected the correct date(s) press the Enter key. The time range and report op‑
tions can now be selected.

Selecting tiMeS and rePort oPtionS

After selecting the range of dates a screen similar to the following will be displayed.

                                  Query Report

                    Start Date:         09-11-11
                    Start Time:         00:00:00

                    End Date:           09-11-11
                    End Time:           23:59:59

                    Record Details:     No Details (1)

                    Reverse order:            No
                    Report Type:            Dump

 Inputs:
 (blank=all)

                           [F1]=Execute Report, ESC=cancel

Query Events Command – Times and Report Options

The highlight will be located in the hour position of the Start Time field. The Start Date and End Date fields 
will be inaccessible as they were assigned as the result of the date selection process. There are six fields 
that you can control within the Query command. The use of each of these is described in the sections 
that follow.

Start Time and End Time – Event Records are time stamped using the 24‑hour clock convention. To 
change either the Start Time or End Time move the highlight to the appropriate hour, minute or second 
field and enter a new value. Leading zeros are not required. Moving the highlight will accept the new 
value.

Record D�etails – The Record Details setting controls the amount of data included within each Event 
Record. The number in parenthesis (e.g., 1) indicates the number of text lines per Event Record. The lat‑
ter can range from one to four. All of the options are fully described in Task 13 entitled “Event Record 
Formatting Options”. Press the Spacebar one or more times to change the Record Details setting.

Reverse Order – The Reverse Order option allows you to list Event Records in either forward or reverse 
chronological order. Selecting No will issue records starting from the oldest. Selecting Yes will issue records 
starting from the newest. Press the Spacebar to toggle the setting.

Report Type – The Report Type option can be assigned one of three settings. They are: Dump, Browse 
and Comma. Dump is the subject of Task 10 entitled “Query Using the Dump Option”. Press the 
Spacebar until the Browse setting is highlighted. Browse allows you to view records at your leisure. It 
will display multiple records, one screen at a time. This option should be selected if you intend to view 
records but not save them to a PC file. The records will be displayed indefinitely until you press the Esc 
key or advance forward or backward to a new record or set of records. The number of records listed per 
screen will vary with the Record Details setting. A sample report is shown at the end of the next section.
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Inputs – The Inputs option can be left blank (default setting) in which case every record satisfying the 
assigned date and time requirements will be included within the report. However, the Inputs option can 
also be used to issue the report listing a specific (i.e., filtered) set of inputs.

A specific Digital Input can be entered as Dn. A range of Digital Inputs can be entered as Dn‑n. Analog 
and System Inputs use a prefix of A and S, respectively. Leading zeros are not required. Use a space to 
separate different groups of inputs. Press the Enter key to accept the inputs you have selected. Table 3 
lists the single‑letter code that is used to identify each input type.

Letter Code Type of Input

D Digital
A Analog
V *Virtual
T *Timer
F *Flashing
S System

Table 3: Input Type Identifiers

The single‑letter codes V, T and F can be ignored. The Metra‑defined Setup Databases do not implement 
any Virtual, Timer or Flashing Inputs.

By way of example, setting the Inputs field to D1‑10 D17 A1 S4‑6 will allow you to view records from Digital 
Inputs 1 through 10 and 17, Analog Input 1 and System Events 4, 5 and 6.

After the six Query fields are properly assigned press the F1 function key. After a short delay the report will 
be available for viewing. A single‑line, sample report (i.e., not listing any additional details) is shown in the 
following.

                                 Browse Events
13:32:20.01  09/11/11  ISLAND CIRCUIT-2T     ISLD-2T   TK UP     D13

13:32:21.50  09/11/11  W CONST WARNING-2T    WCWTD-2T  TK UP     D12

13:32:21.73  09/11/11  GC&XR-B               GC&XR-B   WARN OFF  D20

13:32:21.76  09/11/11  GC&XR-F               GC&XR-F   WARN OFF  D19

13:32:23.07  09/11/11  SOUTH GATE            SG DWN    NOT DWN   D28

13:32:25.27  09/11/11  WEST WRAP-2T          WWRAP-2T  TK UP     D11

13:32:29.15  09/11/11  ALL GATES UP          GATE UP   GATES UP  D26

13:32:29.77  09/11/11  FLASH RATE 1          FLASH 1   FLASHOFF  D22 46.0FPM

13:32:29.77  09/11/11  FLASH RATE 2          FLASH 2   FLASHOFF  D24 47.5FPM

13:33:26.78  09/11/11  EAST WRAP-2T          EWRAP-2T  TK UP     D15

14:00:00.21  09/11/11  GPS Clock Record      GPS Rec   OFF       S06 0.00SEC

[DOWN]=Next Page [UP]=Prev Page [RIGHT]=Next Event [LEFT]=Prev Event [ESC]=Quit

Query Events Command – Report Type Set to Browse

As the legend at the bottom of the report indicates, the arrow keys can be used to view additional re‑
cords either one at a time or a full screen at a time. After you have reviewed all of the records of interest, 
press the Esc key to exit and return to the Main Menu.

froM the front Panel
To view Event Records using the front panel keypad, perform the steps listed in the following.

1. Press the Browse key. The following menu of commands will be displayed.
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      Browse:
   Event Records
   Input Status
   Flash Rate

Browse Command

2. Using the up and down arrow keys, highlight the Event Records option. Press the Enter key. One or 
more dates arranged and formatted similar to the following will be displayed.

082511 082611 082711
082811 082911 083011
083111 090111 090211
090311 090411 090511

Browse Command – Table of Dates

3. In the previous example, 12 dates are listed in MMDDYY format. Only 12 dates can be displayed at 
once; however, as many as 128 different dates can be selected. Use the arrow keys to highlight the 
date of interest. Press the Enter key.

4. The following Start Time selection field will be displayed.

Browse Event Records

Start Time: 00:00:00

Browse Command – Start Time

5. Proceed directly to the next step to view records starting at midnight (i.e., 00:00:00). To select a dif‑
ferent start time, first move the highlight to the desired field. From left to right the fields are: hours, 
minutes and seconds. To change the currently displayed setting press the Enter key followed by the 
appropriate numeric key(s). Leading zeros are not required. Accept the new setting by pressing the 
Enter key once again. Repeat this procedure for the other fields as required. 

6. Press the Esc key. The following information message will be displayed briefly.

Use ←→↑↓ to scroll,
Browse to select
input to query

7. The first Event Record satisfying the selected date and time criteria will be displayed. A sample record 
from Digital Input D13 is shown in the following.

13:32:20.01 09-11-11
D13     11..x.......
ISLAND CIRCUIT-2T
ISLD-2T     TK UP   

Event Record – Digital Input

The section entitled “From the Front Panel” on page 45, which is a part of Task 13, provides an expla‑
nation of how Event Records are formatted at the LCD.

8. Press the up and down arrow keys to view the next record in the chronological sequence.
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9. Press the Browse key at any time to view records from a specific input. The following input selection 
field will be displayed.

Input to query,
(--- selects all)
         ---

Browse Command – Selected Input

10. Start by pressing the Alpha key. The letter D will be displayed to indicate a Digital Input Number can 
now be entered.

11. Continue to press the Alpha key until the desired input type is highlighted. The Input Number can be 
entered by pressing the appropriate numeric key. Leading zeros are not required. Finally, press the 
Enter key to complete the selection. The first Event Record satisfying the date, time and input criteria 
will be displayed.

12. Press the up and down arrows keys to view the next record in the chronological sequence.

13. Press the Browse key at any time to select another input for viewing.

14. When the last record of interest has been viewed, press the Esc key to return to the Idle Mode.

related featureS

PauSing, reStarting and terMinating a duMP rePort
Setting the Report Type field to Dump rather than Browse also allows you to view records. However, the 
Dump setting will stream all of the records one after the other. This feature makes it ideal for capturing 
records to a PC file. If you use the Dump setting to view records, the streaming can be paused by press‑
ing the Ctrl and S keys simultaneously. To restart the streaming, press the Ctrl and Q keys simultaneously. 
Press the Esc key at any time to terminate the report, otherwise it will terminate automatically. At the 
end of the report the number of records will be listed along with a checksum that is unique to the report’s 
record content.

Be aware that HyperTerminal will occasionally garble text within its window that has been scrolled back‑
wards and then forwards. This is not a recorder‑related problem.

SaVing eVent recordS to a Pc file
This task described how to view Event Records using HyperTerminal. Saving records to a PC file is the sub‑
ject of Task 10 entitled “Query Using the Dump Option”.

SaVing eVent recordS to a uSb flaSh driVe
Your recorder includes a USB Host Port. This feature allows you to save Event Records directly a USB flash 
drive for later viewing at your PC. The procedure used to create and save an Event Record file to a flash 
drive can be performed from the front panel of the unit. A PC is not required. Task 11 entitled “Saving 
Event Records to a USB Flash Drive” describes this procedure.
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SaVe eVent recordS to a Pc file

Query uSing the duMP oPtion
The Query Events command can also be used to save Event Records to a PC file. The command allows 
you to select a range of dates and times for the data that is of interest to you. Several additional features 
control the range and content of the saved records.

The Query Events command is available to Administrative and Restricted Access sessions.

before you Start
This task assumes you have already connected the recorder to a PC running HyperTerminal and you 
have logged on to the recorder with the Administrative Password. The first four tasks of this guide explain 
how to prepare your PC and the log on procedure. The Main Menu should be displayed.

To follow the examples cited in this task, your recorder must have Event Records logged to memory 
spanning two or more days.

what to do
From the Main Menu select the Query Events command. A screen similar to the following will be dis‑
played.

Query Events Command – Table of Dates

                             Select Range of Dates

 08-25-11  08-26-11  08-27-11  08-28-11  08-29-11  08-30-11  08-31-11  09-01-11
 09-02-11  09-03-11  09-04-11  09-05-11  09-06-11  09-07-11  09-08-11  09-09-11
 09-10-11  09-11-11  09-12-11  09-13-11  09-14-11  09-15-11  09-16-11  09-17-11
 09-18-11  09-19-11  09-20-11

    Use arrow keys to move, Space=start selection, Enter=accept, ESC=cancel

In the previously cited sample data, 27 consecutive dates are displayed. As many as 128 dates can be 
listed. At least one Event Record was logged to memory for each date listed. The highlight will always be 
located at the first date position (e.g., 08‑25‑11). A two‑step process is required to save records. First, a 
date or range of dates must be selected. It is followed by selecting a range of times and report options.

Selecting dateS

To select the date(s) perform either of the following procedures.
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•	 To view records from a single date simply move the highlight to the desired date.

•	 To view records from two or more contiguous dates, move the highlight to the first date in the range. 
Press the Spacebar to anchor this position. Use the arrow keys to extend the highlight to encompass 
additional dates.

After the highlight has selected the correct date(s) press the Enter key. The time range and report op‑
tions can now be selected.

Selecting tiMeS and rePort oPtionS

After selecting the range of dates a screen similar to the following will be displayed.

                                  Query Report

                    Start Date:         09-11-11
                    Start Time:         00:00:00

                    End Date:           09-11-11
                    End Time:           23:59:59

                    Record Details:     No Details (1)

                    Reverse order:            No
                    Report Type:            Dump

 Inputs:
 (blank=all)

                           [F1]=Execute Report, ESC=cancel

Query Events Command – Times and Report Options

The highlight will be located in the hour position of the Start Time field. The Start Date and End Date fields 
will be inaccessible as they were assigned as the result of the date selection process. There are six fields 
that you can control within the Query command. The use of each of these is described in the sections 
that follow.

Start Time and End Time – Event Records are time stamped using the 24‑hour clock convention. To 
change either the Start Time or End Time move the highlight to the appropriate hour, minute or second 
field and enter a new value. Leading zeros are not required. Moving the highlight will accept the new 
value.

Record D�etails – The Record Details setting controls the amount of data included within each Event 
Record. The number in parenthesis (e.g., 1) indicates the number of text lines per Event Record. The lat‑
ter can range from one to four. All of the options are fully described in Task 13 entitled “Event Record 
Formatting Options”. Press the Spacebar one or more times to change the Record Details setting.

Reverse Order – The Reverse Order option allows you to list Event Records in either forward or reverse 
chronological order. Selecting No will issue records starting from the oldest. Selecting Yes will issue records 
starting from the newest. Press the Spacebar to toggle the setting.

Report Type – The Report Type option can be assigned one of three settings. They are: Dump, Browse 
and Comma. Browse is the subject of Task 9 entitled “Query Using the Browse Option”. Press the 
Spacebar until the Dump setting is highlighted. Dump allows you to save Event Record data to a PC file 
that can be read using a text editor application (e.g., Notepad®). The procedure for creating and saving 
the file is described in the section entitled “Setting Up Capture Mode” on page 31.

Inputs – The Inputs option can be left blank (default setting) in which case every record satisfying the 
assigned date and time requirements will be included within the report. However, the Inputs option can 
also be used to issue the report listing a specific (i.e., filtered) set of inputs.

A specific Digital Input can be entered as Dn. A range of Digital Inputs can be entered as Dn‑n. Analog 
and System Inputs use a prefix of A and S, respectively. Leading zeros are not required. Use a space to 
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separate different groups of inputs. Press the Enter key to accept the inputs you have selected. Table 4 
lists the single‑letter code that is used to identify each input type.

Letter Code Type of Input

D Digital
A Analog
V *Virtual
T *Timer
F *Flashing
S System

Table 4: Input Type Identifiers

The single‑letter codes V, T and F can be ignored. The Metra‑define Setup Databases do not implement 
any Virtual, Timer or Flashing Inputs.

By way of example, setting the Inputs field to D1‑10 D17 A1 S4‑6 will allow you to view records from Digital 
Inputs 1 through 10 and 17, Analog Input 1 and System Events 4, 5 and 6.

Setting uP caPture Mode

After the six Query fields are properly assigned, HyperTerminal must be configured to capture and save 
the Event Records. Event Records are comprised of simple text characters. To save records as a file the 
capture text feature of HyperTerminal is used as described in the following.

1. Click the command named “Transfer” from the HyperTerminal menu bar.

2. Click the sub‑command named “Capture Text...”. A dialog box similar to the following will be dis‑
played.

HyperTerminal – Capture Text Dialog Box

3. Click the button labeled “Browse...”. A dialog box similar to the following will be displayed.
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HyperTerminal – Select Capture File Dialog Box

4. Navigate to or create the folder where the file will be saved. In the edit box labeled “File name:” en‑
ter a descriptive name for the file. The file’s extension should be left as “.TXT”. Click the button labeled 
“Save”.

5. The Capture Text dialog box shown in step 2 will reappear. Click the button labeled “Start”. The 
Captured Text file is now fully specified. The dialog box will close automatically.

6. Press the F1 function key. After a short delay the selected Event Records will scroll across the 
HyperTerminal window while they are being saved to the Captured Text file.

7. The report will terminate automatically. At the end of the report the number of records will be listed 
along with a checksum that is unique to the report’s record content. If at any time you wish to pre‑
maturely terminate the report press the Esc key. The end of a sample report is shown in the following.

13:32:29.77  09/11/11  FLASH RATE 2          FLASH 2   FLASHOFF  D24 47.5FPM

13:33:26.78  09/11/11  EAST WRAP-2T          EWRAP-2T  TK UP     D15

14:00:00.21  09/11/11  GPS Clock Record      GPS Rec   OFF       S06 0.00SEC

Number of records = 34  Checksum = 3523
End of report
Hit any key to continueHit any key to continue

End of Sample Report

8. Once the report has been completed or terminated, click the command named “Transfer” from the 
HyperTerminal menu bar.

9. Close the Captured Text file by clicking the sub‑command named “Capture Text > Stop”.

Between the time you start and stop the capture mode, HyperTerminal will save every Event Record 
character along with every one of your keystrokes. Press the F1 function key only after the Captured Text 
file is fully specified. Additionally, do not press any keys until after the report has been completed and the 
Captured Text file is closed.

10. Press the Esc key to exit and return to the Main Menu.
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related featureS

View a caPtured text file
The Captured Text file includes, by default, a .txt file extension. The file can be viewed and printed using 
any word processing application (e.g., Notepad or Word®). To open the file, use Windows Explorer to 
navigate to the folder you selected in step 4. Double‑click the file of interest. Unless you specify other‑
wise, the Captured Text file will open in your default text file application.

PauSing, reStarting and terMinating a duMP rePort
You can view Event Record data by setting the Report Type field to Dump and not creating a capture 
file. However, the Dump setting will stream all of the records one after the other. The streaming can be 
paused by pressing the Ctrl and S keys simultaneously. To restart the streaming, press the Ctrl and Q 
keys simultaneously. Press the Esc key at any time to terminate the report, otherwise it will terminate 
automatically. At the end of the report the number of records will be listed along with a checksum that is 
unique to the report’s record content.

Be aware that HyperTerminal will occasionally garble text within its window that has been scrolled back‑
wards and then forwards. This is not a recorder‑related problem.

browSing eVent recordS
This task described how to save Event Records using HyperTerminal. To view records one screen at a time 
(i.e., no streaming) refer to Task 9 entitled “Query Using the Browse Option”.

SaVing eVent recordS to a uSb flaSh driVe
Your recorder includes a USB Host Port. This feature allows you to save Event Records directly to a USB 
flash drive for later viewing at your PC. The procedure used to create and save an Event Record file to 
a flash drive can be performed from the front panel of the unit. A PC is not required. Task 11 entitled 
“Saving Event Records to a USB Flash Drive” describes this procedure.



Metra training guide

34 Micro‑Aide

10

uSer noteS



35Micro‑Aide

11

how to . . .

Task 
11

SaVe eVent recordS without uSing a Pc

SaVing eVent recordS to a uSb flaSh driVe
The front panel of your Event Recorder includes a USB Host Port. The port is designed to accept com‑
monly available flash drives (aka thumb drives). This capability allows you to save Event Record data 
without using a PC. The portability of the flash drive allows you to review and share your record data as 
you please.

The front panel Save command is available to all users.

before you Start
This task requires that you have access to a USB flash drive. A PC is not required to save the records to the 
drive. However, a PC with a word processing application installed (e.g., Notepad or Word) is required to 
review the records.

To follow the examples cited in this task, your recorder must have Event Records logged to memory 
spanning two or more days.

what to do
Your recorder allows you to quickly save all of the Event Records from a complete day. A slightly different 
procedure is used to save records from a specific range of dates and times. Follow the steps listed in the 
appropriate section.

SaVing eVent recordS froM a coMPlete day
1. Insert the USB flash drive into the front panel connector labeled “USB Host Port”.

2. Press the Save/. key. The following message will be displayed.

Save to flash drive:
 Records for one day
 Records for a range

Save Command

3. Press the Enter key after highlighting the Records for one day option.

4. A table of dates similar to the following will be displayed.

082511 082611 082711
082811 082911 083011
083111 090111 090211
090311 090411 090511

Table of Dates
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At least one Event Record will be logged for each date listed. Dates are listed in the MMDDYY format. 
The Event Records option may list as many as 128 dates. Only 12 dates are listed in the example cited 
previously. The up and down arrow keys can be used to scroll quickly through a large collection of 
dates.

5. Press the Enter key after highlighting a date. The following message will be displayed briefly after the 
delay required to create the text file.

Writing events.txt  
Writing events.bin  
Writing setupdata   
      Success!      

6. Records from additional complete days can be saved by repeating this procedure starting at step 2.

7. Remove the flash drive from the USB Host Port after all the required records have been saved.

SaVing eVent recordS froM a range of tiMeS and dateS
1. Insert the USB flash drive into the connector labeled “USB Host Port”.

2. Press the Save/. key. The following message will be displayed.

Save to flash drive:
 Records for one day
 Records for a range

Save Command

3. Press the Enter key after highlighting the Records for a range option.

4. A table of dates similar to the following will be displayed. The dates represent the available start date 
of the range.

082511 082611 082711
082811 082911 083011
083111 090111 090211
090311 090411 090511

Table of Dates – Select Start Date

At least one Event Record will be logged for each date listed. Dates are listed in the MMDDYY format. 
The Event Records option may list as many as 128 dates. Only 12 dates are listed in the example cited 
previously. The up and down arrow keys can be used to scroll quickly through a large collection of 
dates.

5. Press the Enter key after highlighting a date. The following message will be displayed.

Start time:
Enter=edit, Esc=OK
      00:00:00

Select Start Time

6. To accept the 00:00:00 midnight setting as the start time, press the Esc key. To modify the start time 
move the highlight to the hours, minutes or seconds position. Press the Enter key. Press the number 
keys as required to create a new value. The recorder utilizes a military‑style clock. Accordingly, 
12:01:02 AM is defined as 00:01:02 and 12:59:58 PM is defined as 23:59:58. Leading zeros are not 
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required. To accept the new value, press the Esc key. Using the same technique, adjust the other 
values as required. When the start time is correct, press the Esc key.

7. A table of dates similar to the following will be displayed. The dates represent the available end date 
of the range.

082511 082611 082711
082811 082911 083011
083111 090111 090211
090311 090411 090511

Table of Dates – End Date

8. Press the Enter key after highlighting a date. The following message will be displayed.

End time:
Enter=edit, Esc=OK
      23:59:59

Select End Time

9. To accept the 23:59:59 setting as the end time, press the Esc key. To modify the end time use the 
procedure described in step 6. When the end time is correct, press the Esc key.

10. The following message will be displayed briefly after the delay required to create the text file.

Writing events.txt  
Writing events.bin  
Writing setupdata   
      Success!      

11. Records from other times and dates can be saved by repeating this procedure starting at step 2.

12. Remove the flash drive from the USB Host Port after all the required records have been saved.

related featureS

fileS written to the flaSh driVe
As noted in step 4 of the previous section, this procedure writes three different files to your drive. The first 
is a simple text file consisting of Event Records. The second is a smaller binary version of the same Event 
Record data. The third is another binary file that contains the complete contents of the Setup Database 
used by the recorder. The latter two files are used exclusively by MICRO‑AIDE’s GEA (Graphical Event 
Analyzer) software.

The following Windows Explorer screen shows the contents of a recorder data file named “DIST_SUBDR_
XING‑NAME” which has been saved to a USB flash drive and is now installed as Drive F of the PC. The 
three files associated with the Save command, as described in this task, are shown in the right‑side win‑
dow pane.
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Windows Explorer – Folder and Files Written to Flash Drive

reViewing the text file
The text version of the Event Record data will include a .txt file extension. The file can be viewed and 
printed using any word processing application. To open the file insert the USB flash drive into an available 
USB port on your PC. Use Windows Explorer to navigate to the drive. The text file of interest will be saved 
in a folder named after the first 20 characters of the assigned Unit Name. Unit Names are the subject of 
Task 5. Double‑click the file of interest. Unless you specify otherwise, the file will open in your default 
text file application.

The text and binary files you save to your USB flash drive are always saved in a folder unique to the re‑
corder. Additionally, each text file is assigned a specific filename that eliminates confusion with other files 
in the same folder. A typical file may be named as follows: 09‑11‑11@231223‑100511.txt. The format of the 
filename is illustrated in Figure 1.

Figure 1: Filename Format Used by USB Host Port

Date
file was created

(MMDDYY)

Date of 1st
record saved
(MM-DD-YY)

09-11-11@231223-100511.txt

Time of day
file was created

(hhmmss)
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View eVent recordS in real‑tiMe

View eVentS aS they occur
In some cases it may be advantageous to view and/or capture Event Records as they occur in real‑time. 
The View Events command provides this capability. Its use is similar to that of the Query Events command 
with the Dump option selected.

The View Events command is available to Administrative and Restricted Access sessions.

before you Start
This task assumes you have already connected the recorder to a PC running HyperTerminal and you 
have logged on to the recorder with the Administrative Password. The first four tasks of this guide explain 
how to prepare your PC and the log on procedure. The Main Menu should be displayed.

what to do
From the Main Menu select the View Events command. A screen similar to the following will be displayed.

View Events Command

                               View Events Report

                    Include Details:    No Details (1)

 Inputs:
 (blank=all)

                           [F1]=Execute Report, ESC=cancel

The content of the ensuing report is controlled by the Include Details and Inputs settings. Their use is de‑
scribed in the following two sections.

Include D�etails – The include Details setting controls the amount of data included within each Event 
Record. The number in parenthesis (e.g., 1) indicates the number of text lines per Event Record. The lat‑
ter can range from one to four. All of the options are fully described in Task 13 entitled “Event Record 
Formatting Options”. Press the Spacebar one or more times to change the Record Details setting.

Inputs – The Inputs setting can be left blank (default setting) in which case every record satisfying the 
assigned date and time requirements will be included within the report. However, the Inputs setting can 
also be used to issue the report listing a specific (i.e., filtered) set of inputs.

A specific Digital Input can be entered as Dn. A range of Digital Inputs can be entered as Dn‑n. Analog 
and System Inputs use a prefix of A and S, respectively. Leading zeros are not required. Use a space to 
separate different groups of inputs. Press the Enter key to accept the inputs you have selected. Table 5 
on page 40 lists the single‑letter code that is used to identify each input type.
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Letter Code Type of Input

D Digital
A Analog
V *Virtual
T *Timer
F *Flashing
S System

Table 5: Input Type Identifiers

The single‑letter codes V, T and F can be ignored. The Metra‑defined Setup Databases do not implement 
any Virtual, Timer or Flashing Inputs.

By way of example, setting the Inputs field to D1‑10 D17 A1 S4‑6 will allow you to view records from Digital 
Inputs 1 through 10 and 17, Analog Input 1 and System Events 4, 5 and 6.

After the two View Events fields are properly assigned press the F1 function key. After a short delay the 
report will be available for viewing. A brief sample report, set to No Details, is shown in the following.

13:32:29.77  09/11/11  FLASH RATE 2          FLASH 2   FLASHOFF  D24 47.5FPM

13:33:26.78  09/11/11  EAST WRAP-2T          EWRAP-2T  TK UP     D15

14:00:00.21  09/11/11  GPS Clock Record      GPS Rec   OFF       S06 0.00SEC

View Events Command – Include Details Set to No Details

After you have viewed all of the records of interest, press the Esc key to terminate the report and return 
to the Main Menu.

related featureS

SaVing real‑tiMe eVent recordS to a Pc file
The capture text to a file feature of HyperTerminal can be used to save real‑time Event Records. The 
procedure for doing so is described in the section entitled “Setting Up Capture Mode” on page 31. 
Remember to press the F1 function key only after the Captured Text file has been opened and named.

View a caPtured text file
The Captured Text file includes, by default, a .txt file extension. The file can be viewed and printed using 
any word processing application (e.g., Notepad or Word). To open the file, use Windows Explorer to navi‑
gate to the file of interest. Unless you specify otherwise, the Captured Text file will open in your default 
text file application.

PauSing, reStarting and terMinating a View eVentS rePort
The View Events command will stream records to your PC as they occur in real‑time. The streaming can 
be paused by pressing the Ctrl and S keys simultaneously. To restart the streaming, press the Ctrl and Q 
keys simultaneously. Press the Esc key at any time to terminate the report, otherwise it will continue on 
indefinitely.

Be aware that HyperTerminal will occasionally garble text within its window that has been scrolled back‑
wards and then forwards. This is not a recorder‑related problem.

eVent recordS Viewed at the lcd
Event Records will also be displayed in real‑time at the LCD panel. The record will only be displayed 
briefly, however. This is done, not to provide a readable record, but rather as an indication that the Event 
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Recorder’s most critical task is functioning properly. It follows that a failure to display record activity at 
the LCD is perhaps an indication that events are not being logged to memory. A typical Event Record 
from Digital Input D1 is shown in the following.

13:32:20.01 09-11-11
D13     11..x.......
ISLAND CIRCUIT-2T
ISLD-2T     TK UP   

Event Record – Digital Input

Viewing liVe StatuS
The current state of all Digital and Analog Inputs can also be viewed. Refer to Task 14 entitled “Live 
Status Views”.
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Task 
13

Select and interPret eVent record content

eVent record forMatting oPtionS
Your recorder can format Event Records to include varying degrees of content. These options allow you 
to inspect the status of all Digital Inputs and Analog Input voltage levels simultaneously. Irrespective of 
the formatting option you select, the first line of each record will always list the time, date, input identity 
and type of event.

All Event Record formatting options are available to Administrative and Restricted Access sessions

before you Start
The primary purpose of this task is to provide useful information to the user. At the completion of this task 
you will understand the content of all Event Records. This applies to records displayed at the monitor of 
your PC or as seen at the recorder’s front panel LCD.

Sample records are listed throughout this task. However, if the user wishes to review actual Event 
Records, a PC running HyperTerminal will have to be connected to the recorder. The first four tasks of this 
guide explain how to prepare your PC and log on. Additionally, several Event Records from various inputs 
will have to be saved in the memory of the recorder.

eVent record content

uSing a Pc and hyPerterMinal
The Main Menu includes two commands that allow the user to view and/or capture Event Records while 
using a PC. The Query Events command is the subject of Task 9 and Task 10. The View Events com‑
mand is described in Task 12. Included within these commands is the ability to selectively control the 
content of the displayed Event Records. The Query Events and View Events commands use the Record 
Details and Include Details settings, respectively, to control the content. Five identical settings are avail‑
able with each command. The settings and resultant content are summarized in Table 6.

Record D�etails & Include D�etails 
Settings D�escription Lines 

of Text

No Details (1) Event Record with no added details 1
Digital Details (2) Event Record with status of all other Digital Inputs 2
Analog Details (2) Event Record with voltages of all 8 Analog Inputs 2
Virtual Details (2) Event Record with status of all Virtual Inputs 2
All Details (4) Event Record with Digital, Analog and Virtual data 4

Table 6: Formatting Options

In the sections that follow, each setting is described and examples of the resultant Event Record content 
are cited. The same Event Records are used in each example. Only their formatting options have been 
varied. The descriptions are listed in order of increasing detail.

no detailS

In the vast majority of cases you will select the No Details option. Its text is concise and easy to interpret. 
Two sample records are illustrated in Figure 2 on page 44. The first record is from Digital Input D13. The 
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second is from Digital Input D22. According to the Mainline Setup Database, D22 is connected to one of 
the flashing outputs of the FLD‑2. Accordingly, the Off Event reported includes a flash rate of 46.0 fpm.

Figure 2: 

Input Name
(up to 20 char.)

Event Name
(up to 8 char.)

Flash
Rate

Time of Day
(hh:mm:ss.ss)

Date
(MM/DD/YY)

Input Identifier
(up to 8 char.)

Input
Number

1 5 : 3 2 : 2 9 . 7 7   0 9 / 1 1 / 1 1   F L A S H  R A T E  1           F L A S H  1    F L A S H O F F   D 2 2   4 6 . 0 F P M

1 5 : 3 2 : 2 0 . 0 1   0 9 / 1 1 / 1 1   I S L A N D  C I R C U I T - 2 T      I S L D - 2 T    T K  U P      D 1 3

No Details Options

The entire content of an Event Record formatted with the No Details option is included as the first line of 
text in all other options.

Event Records saved to the USB flash drive always use the No Details formatting option.

digital detailS

This formatting option includes information regarding the status of all other Digital Inputs at the time the 
event was recorded. This option can be useful as it provides an instantaneous snapshot of the Digital 
Inputs. The second line of text, when read from left to right, indicates the status of Digital Inputs D1 
through D64 (see trailing note). The following characters are used to denote the status information.

Upper-case (X)� – This Digital Input transitioned from Off to On. It is the source of the Event Record.

Lower-case (x)� – This Digital Input is in its On state. It is not the source of the Event Record.

Semi-colon (:)� – This Digital Input transitioned from On to Off. It is the source of the Event Record.

Period (.)� – This Digital Input is in its Off state. It is not the source of the Event Record.

Figure 3: 

D22
On to Off

D13
Off to On

. . . . . . x . . x  x . x . x . . . x .  . : . . . x . . . .  . . . . . . . . . .  . . . . . . . . . .  . . . . . . . . . .  . . . .
1 5 : 3 2 : 2 9 . 7 7   0 9 / 1 1 / 1 1   F L A S H  R A T E  1           F L A S H  1    F L A S H O F F   D 2 2   4 6 . 0 F P M

x . x x . . x . . x  . x X . x . . . x .  . . . . . x . . . .  . . . . . . . . . .  . . . . . . . . . .  . . . . . . . . . .  . . . .
1 5 : 3 2 : 2 0 . 0 1   0 9 / 1 1 / 1 1   I S L A N D  C I R C U I T - 2 T      I S L D - 2 T    T K  U P      D 1 3

Digital Details Option

Digital Inputs D33 through D64 can be ignored for the CWR‑40E.

analog detailS

This formatting option will report the voltages of all eight Analog Inputs at the time the event was 
recorded. This option can be useful as it provides an instantaneous snapshot of the Analog Inputs. The 
second line of text, when read from left to right, lists the levels of Analog Inputs A1 through A8. The fol‑
lowing characters, appended to the end of each reading, are used to provide additional information as 
explained in the following.
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Asterisk (*)� – This Analog Input has transitioned into its unacceptable range of operation. It is the source 
of the Event Record.

Exclamation Mark (!)� – This Analog Input remains in its unacceptable range of operation. It is not the 
source of the Event Record.

Equal Sign (=)� – This Analog Input has transitioned into its acceptable range of operation. It is the source 
of the Event Record.

Blank ( )� – This Analog Input remains in its acceptable range of operation. It is not the source of the Event 
Record.

Figure 4: 

Analog Input
A8

Analog Input
A1

In Acceptable
Range

In Unacceptable
Range

1 5 : 3 2 : 2 9 . 7 7   0 9 / 1 1 / 1 1   F L A S H  R A T E  1           F L A S H  1    F L A S H O F F   D 2 2   4 6 . 0 F P M

1 5 : 3 2 : 2 0 . 0 1   0 9 / 1 1 / 1 1   I S L A N D  C I R C U I T - 2 T      I S L D - 2 T    T K  U P      D 1 3
 1 3 . 1 V d c   1 5 . 2 V d c   1 3 . 1 V d c   1 3 . 0 V d c    9 . 1 V d c    0 . 0 V d c !   0 . 0 V d c !   1 1 4 V a c

 1 3 . 1 V d c   1 5 . 3 V d c   1 3 . 3 V d c   1 3 . 0 V d c    8 . 8 V d c !   0 . 0 V d c !   0 . 0 V d c !   1 1 5 V a c

Analog Details Option

Virtual detailS

The Virtual Details option also adds a second line of text to the Event Record. It lists the state of each 
of the 32 Virtual Inputs. However, the Metra‑defined Setup Databases do not include definitions for any 
Virtual Inputs. This formatting option can be ignored.

all detailS

The All Details option is self‑explanatory. It formats each record using four lines of text. The first is un‑
changed as it is common to all formatting options. The second line can be ignored as it lists the state of 
Virtual Inputs (see previous section). The third line lists the state of all Digital Inputs. Finally, the fourth line 
lists the present voltage level for each Analog Input.

Figure 5 illustrates the Event Records, previously cited, with the All Details formatting option selected.

Figure 5: 

1 5 : 3 2 : 2 9 . 7 7   0 9 / 1 1 / 1 1   F L A S H  R A T E  1           F L A S H  1    F L A S H O F F   D 2 2   4 6 . 0 F P M

1 5 : 3 2 : 2 0 . 0 1   0 9 / 1 1 / 1 1   I S L A N D  C I R C U I T - 2 T      I S L D - 2 T    T K  U P      D 1 3

 1 3 . 1 V d c   1 5 . 2 V d c   1 3 . 1 V d c   1 3 . 0 V d c    9 . 1 V d c    0 . 0 V d c !   0 . 0 V d c !   1 1 4 V a c

 1 3 . 1 V d c   1 5 . 3 V d c   1 3 . 3 V d c   1 3 . 0 V d c    8 . 8 V d c !   0 . 0 V d c !   0 . 0 V d c !   1 1 5 V a c

x . x x . . x . . x  . x X . x . . . x .  . . . . . x . . . .  . . . . . . . . . .  . . . . . . . . . .  . . . . . . . . . .  . . . .
. . . . . . . . . .  . . . . . . . . . .  . . . . . . . . . .  . .

. . . . . . . . . .  . . . . . . . . . .  . . . . . . . . . .  . .

. . . . . . x . . x  x . x . x . . . x .  . : . . . x . . . .  . . . . . . . . . .  . . . . . . . . . .  . . . . . . . . . .  . . . .

All Details Option

froM the front Panel
The front panel keypad allows the user to perform a variety of tasks. Among these is the ability to view 
Event Records at the LCD. This feature is described in Task 9 in the section entitled “From the Front 
Panel”. Listed in the following are two sample Event Records as they would appear at the LCD. The for‑
matting of each type is fully described.
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digital eVent record

The first Event Record included in the previous section is depicted in the following as it would appear at 
the LCD.

13:32:20.01 09-11-11
D13     11.XX.X...X.
ISLAND CIRCUIT-2T
ISLD-2T      TK UP

Event Record – Digital Input

The LCD record data is described in the following from top to bottom and left to right.

First line – The time is reported in hh:mm:ss.ss format. The date is listed in MM‑DD‑YY format.

Second Line – The Input Number is listed (e.g., D13). A group of . and x characters are used to indicate 
the status of 10 Digital Inputs. A . indicates the input was Off. An x indicates the input was On. The num‑
ber (e.g., 1, 11, 21, etc.) to the immediate left of the group is used to indicate the first input in the group.

Third Line – The full Input Name is listed.

Fourth Line – The Input Identifier (e.g., ISLD‑2T) is listed. It is followed by the Event Name (e.g., TK UP).

analog eVent record

An Event Record from an Analog Input is formatted very similarly.

16:03:19:06 09-11-11
A02   8.7Vdc.x......
CROSSING BATTERY    
B14-N14     BATT LOW

Event Record – Analog Input

The LCD record data is described in the following from top to bottom and left to right.

First line – The time is reported in hh:mm:ss.ss format. The date is listed in MM‑DD‑YY format.

Second Line – The Input Number is listed (e.g., A02). The measured voltage (e.g., 10.7 Vdc) at the instant 
the record was created is reported. A group of . and x characters are used to indicate the status of all 
eight Analog Inputs. Inputs A1 through A8 are reported from left to right. A . indicates the input was in its 
acceptable range of operation. An x indicates the input was in its unacceptable range of operation.

Third Line – The full Input Name is listed.

Fourth Line – The Input Identifier is listed (e.g., B14‑N14). It is followed by the Event Name (e.g., BATT LOW).

related featureS

analog liMit ValueS
Limit Values and how they are used to define acceptable and unacceptable ranges of operation for 
Analog Inputs is the subject of Task 15 entitled “Configuring Analog Inputs for Use with Batteries and AC 
Power”.

Viewing liVe StatuS
The current state of all Digital and Analog Inputs can also be viewed. Refer to Task 14 entitled “Live 
Status Views”.
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Task 
14

View the current StatuS of inPutS

liVe StatuS ViewS
At times it may be handy to know the current status of several Digital Inputs simultaneously. The state of 
an XR, gate down and flashing indication serves as an example. There are two features of your recorder 
that provide this capability.

The Live Status command and front panel Browse feature are available to Administrative and Restricted 
Access sessions.

before you Start
This task assumes you have already connected the recorder to a PC running HyperTerminal and you 
have logged on to the recorder with the Administrative Password. The first four tasks of this guide explain 
how to prepare your PC and the log on procedure. The Main Menu should be displayed.

what to do

uSing a Pc and hyPerterMinal
From the Main Menu select the Query Events command. A screen similar to the following will be dis‑
played. The sample data is from a CWR‑72E using the Mainline Setup Database.

[ESC]=exit      79 Degrees F      Live Status                 12:59:42 10-05-11

   D01-D32 X . . X . . . . . . . . . . . . . . . . . . . . . . . . . . . X

   D33-D64 X X . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

 VInput01:           VInput02:           VInput03:           VInput04:
 VInput05:           VInput06:           VInput07:           VInput08:
 VInput09:           VInput10:           VInput11:           VInput12:
 VInput13:           VInput14:           VInput15:           VInput16:
 VInput17:           VInput18:           VInput19:           VInput20:
 VInput21:           VInput22:           VInput23:           VInput24:
 VInput25:           VInput26:           VInput27:           VInput28:
 VInput29:           VInput30:           VInput31:           VInput32:

 B12-N12   B14-N14   B-N       BL-NL/E   BL-NL/W                       AC PWR
  13.1Vdc   12.9Vdc   13.2Vdc   13.4Vdc   13.2Vdc    0.0Vdc    0.0Vdc    118Vac
  BATT OK   BATT OK   BATT OK   BATT OK   BATT OK                        PWR ON

Live Status Command

The Live Status report will be continuously updated in real‑time as events are created. The report com‑
prises four sections. Each section is described in the following. 

Header – From left to right, the header lists the internal temperature of the recorder, report title and cur‑
rent time and date.

D�igital inputs – The second section includes two lines of text. It reports the state of each Digital Input. An 
X indicates that the input is On (i.e., voltage is applied to the input). A period character (.) indicates that 
the input is Off (i.e., no voltage is applied to the input). In the sample data, inputs D1, D4, D32, D33 and 
D34 are all On. All other inputs are Off.
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V�irtual Inputs – The third section lists the state of each Virtual Input. This section can be ignored. Virtual 
Inputs are not used in any of the three Metra‑defined Setup Databases.

Analog Inputs – The fourth section comprises three lines of text. The first line lists, from left to right, the 
assigned Identifier for each of the eight Analog Inputs (e.g., B12‑N12). The second line lists the voltage 
at each input. Finally, the third line reports the appropriate Event Name for the voltage at its present 
value. The sample data reports that all voltages are within their acceptable range of operation. Event 
Name reporting is based upon the present measured voltage and how it compares to the assigned Limit 
Values. This procedure is illustrated in Figure 7 on page 22. Event Names are the subject of Task 11.

Press the Esc key to exit and return to the Main Menu.

froM the front Panel
The current status of an individual input can also be viewed directly from the front panel. To use this fea‑
ture, perform the steps listed in the following.

1. Press the Browse key. The following menu of commands will be displayed.

      Browse:
   Event Records
   Input Status
   Flash Rate

Browse Command

2. Using the up and down arrow keys, highlight the Input Status option. Press the Enter key. The following 
information message will be displayed briefly.

Use ←→↑↓ to scroll,
Browse=select input

3. The current status of Digital Input D1 will be displayed. In the following sample data D1 has, by virtue 
of the Mainline Setup Database, been assigned an Input name of W ADJACENT XING‑1T and an Input 
Identifier of WAX‑1T. Its current state is TK DWN.

D01
W ADJACENT XING-1T
WAX-1T      TK DWN

Input Status – Digital Input

To view the status of the preceding or succeeding input, press and release the up or down arrow key, 
respectively. To advance quickly in either direction press and hold the appropriate arrow key.

4. By way of example, view the status of Digital Input D26 by pressing the Browse button. The highlight 
will be alternating between the input type designator (e.g., D) and the number of the input (e.g., 
01). Press the 2 key, followed by the 6 key. Accept the new number by pressing the Enter key. Data 
similar to the following will be displayed.

D26
ALL GATES UP
GATE UP     NOT UP

 Input Status – Digital Input
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The LCD is now reporting the current status of Digital Input D26.

5. View the status of Analog Input A08 by pressing the Browse button. The highlight will be alternating 
between the input type designator (e.g., D) and the number of the input (e.g., 26). Press the Alpha 
key once to change the input type designator to analog (e.g., A). Press the 8 key. Accept the new 
number by pressing the Enter key. Data similar to the following will be displayed.

A08
120/240 VAC POWER
AC PWR      PWR OFF 
               89VAC

Input Status – Analog Input

In this case, Analog Input A8 is reporting a voltage of 89 Vac. This is below the Lower Limit Value of 
90 Vac established by the Mainline Setup Database. Accordingly, the Event Name is reported as 
PWR OFF (as opposed to PWR ON).

Table 7 lists the single‑letter code that is used to identify each input type.

Letter Code Type of Input

D Digital
A Analog
V *Virtual
T *Timer
F *Flashing
S System

Table 7: Input Type Identifiers

The single‑letter codes V, T and F can be ignored. The Metra‑defined Setup Databases do not implement 
any Virtual, Timer or Flashing Inputs.

6. After viewing the status of the last input of interest, press the Esc key to return to the Idle Mode.

Like its Terminal Port counterpart, the Browse Input Status feature reports updated status continuously 
and in real‑time. Unlike its counterpart, it reports the status of only one input at a time.

related featureS

View eVentS aS they occur
This task demonstrated how to view the status of inputs in real‑time. Task 12 entitled “View Events as 
They Occur” describes how to view and capture Event Records in real‑time.



Metra training guide

50 Micro‑Aide

14

uSer noteS



51Micro‑Aide

15

how to . . .

Task 
15

MeaSure a flaSh rate

uSing the MeaSure flaSh rate featureS
Your recorder system allows you to measure and report the flash rate of any flashing circuit equipped 
with incandescent or halogen lamps. The MICRO‑AIDE Failed Lamp Detector (FLD‑2) is used to sense the 
current flow through the lamp circuits. The Flash Pulse (FP) outputs of the FLD‑2 are wired to Digital Inputs 
of the recorder. The FP signals will pulse high and low with each flash of the lamps. The recorder scans 
the pulse sequence and in turn is able to report the average flash rate while the crossing was active.

The Measure Flash Rate command is available to Administrative and Restricted Access sessions.

before you Start
This task assumes you have already connected the recorder to a PC running HyperTerminal and you 
have logged on to the recorder with the Administrative Password. The first four tasks of this guide explain 
how to prepare your PC and the log on procedure. The Main Menu should be displayed.

The Metra‑defined Setup Databases require that flashing outputs of the FLD‑2 be wired to specific Digital 
Inputs of the recorder. Table 8 lists these assignments. Accordingly, only the referenced inputs will be 
configured for flashing operation.

Recorder Type Setup D�atabase Input Names D�igital Inputs

CWR‑72E Mainline FLASH RATE 1, 2, 3, 4 D22, D24, D54, D56
CWR‑40E BEV FLASH RATE 1, 2 D22, D24
CWR‑40E MED FLASH RATE 1, 2 D22, D24

Table 8: Flashing Inputs

what to do

uSing a Pc and hyPerterMinal
From the Main Menu select the Measure Flash Rate command. The following screen will be displayed.

                               Measure Flash Rate

                             Input to Measure: D01

                         [F1] to measure, [ESC] to quit

Measure Flash Rate Command

1. The highlight will be located in the Input to Measure: field. Type D� followed by the Digital Input 
Number of the input to be measured (e.g., D�22).

2. Press the F1 function key to initiate the measurement. A screen similar to the following will be dis‑
played. It may take a few seconds for the value reported in the Flashes/Minute: field to settle to a 
consistent number.
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                               Measure Flash Rate

                             Input to Measure: D22

                            Measuring..., [ESC] to quit

                           Flashes/Minute:  46.9
                           On Time:         0.64 Sec
                           Off Time:        0.64 Sec
                           Cycle Time:      1.28 Sec

                           Detect Time:     0.64 Sec

Measured Flash Rate

3. To terminate the measurement press the Esc key twice to exit and return to the Main Menu.

As shown in the previous screen, the Measure Flash Rate command reports a Detect Time setting. For the 
example cited, this value is the optimum Detection Time to be used for the Digital Input.

Table 9 lists Detection Time settings for the various Flashing Inputs. These values are preassigned as part of 
the Metra‑defined Setup Databases.

Recorder Type Setup D�atabase
D�etection Time 

Flashing Inputs Only 
(seconds)�

CWR‑72E Mainline .55
CWR‑40E BEV .67
CWR‑40E MED .67

Table 9: Detection Times for Flashing Inputs

froM the front Panel
The flash rate of a circuit can also be measured from the front panel without using a PC. To do so per‑
form the following steps.

1. Press the Browse key. The following menu of commands will be displayed.

      Browse:
   Event Records
   Input Status
   Flash Rate

Browse Command

2. Using the up and down arrow keys, highlight the Flash Rate option. Press the Enter key. The following 
will be displayed.

Measure Input:D22

Flash Rate Command

3. If the Digital Input Number listed is already correct, simply proceed to the next step. Otherwise, enter 
the required Input Number by pressing the appropriate numeric keys. Table 8 on page 51 lists the 
Flashing Inputs assigned by each Setup Database.

4. Press the Enter key to accept the displayed input and proceed with the measurement. Data similar 
to the following will be displayed. It may take a few seconds for the value reported in the Flashes/Min: 
field to settle to a consistent number.
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Measure Input:D22
Flashes/Min:  46.9
On/Off:  0.64/  0.64
Cycle Time:  1.28

Measured Flash Rate

5. To terminate the measurement press the Esc key to return to the Idle Mode.

related featureS

flaSh rate rePorting within eVent recordS
An Event Record will be saved to memory each time the Flashing Input signal becomes active (i.e., 
shortly after the crossing is activated). Similarly, an Event Record will be saved to memory shortly after the 
crossing becomes inactive. The latter Event Record will report the average flash rate in flashes per min‑
ute (fpm) while the crossing was active. Refer to the Event Record examples cited in Task 13 entitled 
“Event Record Formatting Options”.

Using the Query command with the input filter option, a maintainer can quickly determine the crossing’s 
flash rate performance over time. Refer to the section entitled “Selecting Times and Report Options” in 
Task 9.

light out detection
The FLD‑2 includes an additional output referred to as Light Out (LO). Like the FP signal, the LO is wired to 
a comparably named Digital Input of the recorder. The LO signal will become active whenever flashing 
is detected and one or more lamps have failed. Any Event Records from these inputs provides cause for 
further testing of the lamp circuits.
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Task 
16

teSt your recorder

running a diagnoStic check
You have the ability to run a series of diagnostic tests of your recorder. The tests can be performed at 
any time to verify the recorder’s health. Each of the tests are non‑destructive. Their selection will not alter 
the recorder’s setup configuration. This task can be performed from a PC or from the front panel.

The Diagnostics command is available to Administrative and Restricted Access sessions.

before you Start
This task assumes you have already connected the recorder to a PC running HyperTerminal and you 
have logged on to the recorder with the Administrative Password. The first four tasks of this guide explain 
how to prepare your PC and the log on procedure. The Main Menu should be displayed.

what to do

uSing a Pc and hyPerterMinal
From the Main Menu select the Diagnostics command. The following menu of commands will be dis‑
played. Each diagnostic test is described in the sections that follow. The various tests can be performed 
in any order that suits the user.

                               System Diagnostics

                               C Checksum Test Program Memory
                               F Flash Memory Test
                               G GPS Receiver Test
                               E Ethernet Test
                               M Modem Test
                               K Keypad Test
                               R Relay Test
                               T Temperature

Diagnostic Command Menu

At the conclusion of each test, press any key to return to the Diagnostic command menu. After all of the 
tests have been completed press the Esc key to exit and return to the Main Menu.

PrograM MeMory teSt

This test verifies the integrity of the program memory. As shown in the following, the test will return a four‑
digit hexadecimal number that is the checksum. The checksum is unique to the firmware version. It will be 
tagged as either GOOD or BAD.

                              Program Memory Checksum=68d6
                                                      GOOD

                                  Test Complete
                            Press any key to continue

Program Memory Test

Versions 1.01 and 1.02 of the CWR‑72E firmware have checksum values of 19b4 and 68d6, respectively.
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flaSh MeMory teSt

This test will return the size (in kilobytes) of the installed Event Record memory. Metra versions of the re‑
corder are equipped with a 2048 KByte (4096 KByte in some cases) flash memory device. The results of the 
test should be similar to the following.

                              Flash Memory #1: 2048K
                              Flash Memory #2: 0K
                              Flash Memory #3: 0K

                                  Test Complete
                            Press any key to continue

Flash Memory Test

A flash memory size of 2048 KBytes yields a memory capacity of 111,481 Event Records.

gPS receiVer teSt

Your Event Recorder is equipped with an internal GPS Receiver and mating external antenna. The GPS 
Receiver allows the recorder’s real‑time clock (RTC) to be automatically and precisely controlled by a 
100% accurate time source.

After power application, the GPS Receiver will take a few minutes to synchronize with an available GPS 
satellite. After sync is achieved, the test results should be similar to the following.

                              GPS Time: 14:29:01.203 is Valid
                              Location: 34.1044°, -117.8784°

                                  Test Complete
                            Press any key to continue

GPS Receiver Test

If the GPS Receiver has temporarily lost sync, the Valid reference will change to Not Valid. This is not nec‑
essarily a concern. The recorder’s RTC is accurate in free‑running mode to within ±.26 seconds per day.

Once sync is achieved the GPS Receiver test will always report time relative to UTC‑0. CST is six hours 
behind UTC‑0 (e.g., 19:00 UTC is 1:00 PM CST. The latitude and longitude of the recorder’s geographical 
location are also reported. 
 
An Event Record is written to memory whenever the recorder’s RTC is adjusted by the GPS time source. 
Refer to the screen entitled “Query Events Command – Report Type Set to Browse” on page 25. The 
last Event Record listed is a GPS clock sync record. Collectively these records can be used to establish a 
performance log of the GPS Receiver.

ethernet Port

The Metra recorders are not equipped with an Ethernet Port. Accordingly, this test can be ignored.

ModeM

Your Event Recorder is also equipped with an internal 33.6 KBaud modem. The Modem test will verify 
that the recorder’s microprocessor is able to dialog with the modem. The results of a successful test are 
displayed in the following.

                              Modem Test in progress...
                              Modem found: H

                                  Test Complete
                            Press any key to continue

Modem Test
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If the recorder’s microprocessor cannot communicate with the modem, the Modem found: H reference 
will be replaced by Modem found: NONE. This should be noted as a failure.

keyPad teSt

This test will return a unique character for each key that is pressed at the front panel.

relay teSt

Your Event Recorder is equipped with two relay outputs. The operation of the relays is controlled by the 
Virtual Input definitions. However, a test of the relays can be performed at any time. The following menu 
of sub‑commands will be displayed after selecting Relay Test.

                                   Relay Test

                                  1 Relay 1 ON
                                  2 Relay 1 OFF
                                  4 Relay 2 ON
                                  5 Relay 2 OFF

Relay Test

Press the appropriate numbered key to operate either relay.

The Metra‑defined Setup Databases do not include any Virtual Input definitions.

teMPerature

As shown in the following example, Temperature reports the internal temperature of the recorder. It is 
typically 10 to 15 °F greater than the external ambient temperature.

                              Unit Temperature  81 Degrees F

                                  Test Complete
                            Press any key to continue

Reported Internal Temperature

The internal temperature should never exceed 180 °F.

froM the front Panel
Alternatively, the Diagnostic tests can be run from the front panel by performing the following steps.

1. Start by pressing the Setup key. The following Passcode challenge will be displayed.

Enter the passcode:

Passcode Challenge

The Mainline, BEV and MED Setup Databases utilize the same Passcode. The Metra‑defined Passcode is 
547. It can only be entered using the numeric keys of the keypad.

2. Press the 547 keys and then the Enter key. The following information message will be displayed briefly.
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Use ←→↑↓ to select 
items and then ENTER

3. The following abbreviated command menu will be displayed.

UName  Modem  Baud
Diag   Update

LCD Command menu

By Metra decision, the accessible front panel commands are limited to those commands available to 
the user during a Restricted Access session.

4. Using the arrow keys, highlight the Diag command. Press the Enter key. The following sub‑menu of 
commands will be displayed.

Select test: ProgMem
FlashMem    GPS Rcvr
Ethernet       Modem
Temperature

Diagnostic Command Menu

5. Any of the six tests can be performed at any time. To perform a test use the arrow keys to position the 
highlight, then press the Enter key. A description of each test is listed in the following sections.

The Relay Test has been excluded from the front panel Diagnostics command menu. This is consistent 
with its treatment within a Restricted Access session.

At the conclusion of each test, press any key to return to the Diagnostic command menu.

ProgMeM

This test verifies the integrity of the program memory. As shown in the following, the test will return a four‑
digit hexadecimal number that is the checksum. The checksum is unique to the firmware version. It will be 
tagged as either (GOOD) or (BAD).

Program Memory
Checksum=68d6 (GOOD)

Hit any key...

Program Memory Test

Versions 1.01 and 1.02 of the CWR‑72E firmware have checksum values of 19b4 and 68d6, respectively.

flaShMeM

This test will return the size (in kilobytes) of the installed Event Record memory. Metra versions of the re‑
corder are equipped with a 2048 KByte (4096 KByte in some cases) flash memory device. The results of the 
test should be similar to the following.
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Flash Mem #1:2048K
          #2:0K
          #3:0K
Hit any key...

Flash Memory Test

A flash memory size of 2048 KBytes yields a memory capacity of 111,481 Event Records.

gPS rcVr

Your Event Recorder is equipped with an internal GPS Receiver and mating external antenna. The GPS 
Receiver allows the recorder’s RTC to be automatically and precisely controlled by a 100% accurate 
time source.

After power application, the GPS Receiver will take a few minutes to synchronize with an available GPS 
satellite. After sync is achieved, the test results should be similar to the following

GPS Rcvr test: Okay
22:20:36.218 Valid
34.1042,-117.8784
Hit any key...

GPS Receiver Test

If the GPS Receiver has temporarily lost sync, the Valid reference will change to Invalid. This is not neces‑
sarily a concern. The recorder’s RTC is accurate in free‑running mode to within ±.26 seconds per day.

Once sync is achieved the GPS Receiver test will always report time relative to UTC‑0. CST is six hours 
behind UTC‑0 (e.g., 19:00 UTC is 1:00 pm CST. The latitude and longitude of the recorder’s geographical 
location are also reported. 
 
An Event Record is written to memory whenever the recorder’s RTC is adjusted by the GPS time source. 
Refer to the screen entitled “Query Events Command – Report Type Set to Browse” on page 25. The 
last Event Record listed is a GPS clock sync record. Collectively these records can be used to establish a 
performance log of the GPS Receiver.

ethernet

The Metra recorders are not equipped with an Ethernet Port. Accordingly, this test can be ignored.

ModeM

Your Event Recorder is also equipped with an internal 33.6 KBaud modem. The Modem test will verify 
that the recorder’s microprocessor is able to dialog with the modem. The results of a successful test are 
displayed in the following.

Modem Test...
Modem found:H

Hit any key...

Modem Test

If the recorder’s microprocessor cannot communicate with the modem, the Modem found: H reference 
will be replaced by Modem found: NONE. This should be noted as a failure.
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teMPerature

As shown in the following example, Temperature reports the internal temperature of the recorder. It is 
typically 10 to 15 °F greater than the external ambient temperature.

Temp  81 Degrees F

Hit any key...

The internal temperature should never exceed 180 °F.

related featureS

in caSe of a teSt failure
A failure in any test should be reported. You can contact MICRO‑AIDE as noted in the following. Our 
“Material Return” and “Limited Warranty” policies are detailed inside the back cover of this guide.

Micro‑Aide corporAtion 
685 Arrow Grand Circle 

Covina, CA 91722 
Tel: 626‑915‑5502     Fax: 626‑331‑9484 

E‑mail: support@micro‑aide.com

mailto:support%40micro-aide.com?subject=Metra%20Support%20Request


61Micro‑Aide

17

how to . . .

Task 
17

inStall the lateSt firMware

uPdate the firMware to a new reViSion
As with any microprocessor‑based product, the various features of the product are largely implemented 
in stored program code referred to as firmware. As new features and capabilities are made available 
you may wish to update the stored firmware. This can be accomplished using either of the two methods 
described in this task.

The Transfer Files / Firmware Upload command is only available to Administrative Access sessions.

getting the lateSt firMware
Before attempting to update the installed firmware, a copy of the new firmware must be available. New 
firmware is posted to the MICRO‑AIDE website at the following web page. 
www.micro‑aide.com/support/downloads.html

The latest firmware will be identified as CWR‑72E Metra. Downloading from the website will yield a zipped 
file. After unzipping, it will yield a file with a .hex extension. This file must be saved to your PC or a USB flash 
drive.

Do not alter the filename of the unzipped .hex file.

before you Start
This task assumes you have already connected the recorder to a PC running HyperTerminal and you 
have logged on to the recorder with the Administrative Password. The first four tasks of this guide explain 
how to prepare your PC and the log on procedure. The Main Menu should be displayed.

what to do

uSing a Pc and hyPerterMinal
From the Main Menu select the Transfer Files command. The following menu of sub‑commands will be 
displayed.

                                 File Transfer

                         D Download Setup Data CWR to PC
                         U Upload Setup Data PC to CWR
                         F Firmware Upload

Transfer Files Command

1. Select the Firmware Upload command. The following precaution will be displayed.

                  Are you SURE you want to upload new Firmware?
                                     No Yes

2. To proceed, select the Yes option. The following instruction will be displayed.

http://www.micro-aide.com/support/downloads.html
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        OK to erase Firmware and upload new Firmware in Intel HEX format?
                                     No Yes

3. To proceed, select the Yes option. The following final precaution will be displayed.

                       Do you want to ABORT this operation
                                     No Yes

4. Select the No option. The following instruction will be displayed.

Please send Intel HEX file now.

5. Click on the command named “Transfer”. It is located in the menu bar at the top of the 
HyperTerminal window. Click on the sub‑command named “Send Text File...”. A dialog box similar to 
the following will be displayed.

HyperTerminal – Send Text File Dialog Box

6. Above the button labeled “Open” is a drop‑down list box. As shown in the previous sample data, se‑
lect “All files (*.*)” from the list of entries. Navigate to and select the file to be sent. It must have a .hex 
file extension. Click the button labeled “Open”.

7. A series of period characters will be displayed. They indicate the progress of the transfer. After a few 
minutes the following message will indicate the successful conclusion of the firmware upload.

Please send Intel HEX file now.
................................................................................
................................................................................
................................................................................
................................................................................
................................................................................
.....
Done!
Press ESC to continue

Firmware Upload Completed

8. Press the Esc key as instructed. The following message will be displayed.

             Do you want to restart the CWR-72E event recorder now?
                                     No Yes
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9. Select the Yes option. The recorder will restart. At the completion of the re‑initialization, the new 
firmware version will be reported in the first line of the password challenge as noted in the following 
sample data.

Model CWR-72E Metra Event Recorder. Ver 1.02 (C) 2011 MICRO-AIDE INC.

DIST_SUBDR_XING-NAME_DOT-NUMBER_MILE-POST-NUMBER

Event storage capacity: 111481

Enter password:

Password Challenge

The recorder will resume its activities consistent with the Setup Database. The Setup Database that was 
previously installed remains unaffected by the firmware update.

froM the front Panel
The firmware can also be updated from the front panel by means of the USB Host Port. A PC is not re‑
quired; however, the new firmware file must be stored on a USB flash drive.

Updating the firmware via the USB Host Port is a feature introduced in version 1.02 of the Metra CWR‑72E 
firmware. The following procedure cannot be performed with earlier versions.

To update the firmware from the front panel perform each of the following steps.

1. Insert the flash drive into the USB Host Port.

2. Press the Setup key. The following Passcode challenge will be displayed.

Enter the passcode:

Passcode Challenge

The Mainline, BEV and MED Setup Databases utilize the same Passcode. The Metra‑defined Passcode is 
547. It can only be entered using the numeric keys of the keypad.

3. Press the 547 keys and then the Enter key. The following information message will be displayed briefly.

Use ←→↑↓ to select 
items and then ENTER

4. The following abbreviated command menu will be displayed.

UName  Modem  Baud
Diag   Update

LCD Command Menu

By Metra decision, the accessible front panel commands are limited to those commands available to 
the user during a Restricted Access session.
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5. Using the arrow keys, highlight the Update command. Press the Enter key. The following message will 
be displayed.

  Update Firmware
From USB Flash Drive
       Yes  No

Update Command

6. Select the Yes option to proceed. The following message will be displayed.

 Insert flash drive
 with HEX file and
     select OK
    CANCEL    OK

7. Select the OK option to proceed. Information similar to the following will be displayed.

Select hex file:
CWR-72E Met V102.hex
CWR-72E Met V101.hex
CWR-72E Met V100.hex

File Selection

8. The Update command allows the user to select a file from a list of nine. The first group of three are 
depicted in the example. To navigate to the second or third group, press the up or down arrow keys.

9. Once the correct file is highlighted, select it by pressing the Enter key.

10. The LCD will indicate that the new firmware file is being transferred. A single‑line progress bar is used 
to indicate transfer activity. After approximately 30 seconds the transfer will automatically terminate  
and the following message will be displayed.

Updating Firmware...
Success!

Press any key...

Successful Update

11. Press the Esc key to proceed. Finally, the following message allows the user to run or ignore (refer to 
closing note) the new firmware. Select the Yes option to execute the new firmware by restarting the 
recorder. The Update procedure has been completed.

Restart Recorder?

       Yes  No

Restart Option

At the completion of the transfer, the new firmware is saved in the non‑volatile memory of the recorder. 
However, the new firmware is not executed until such time as a restart is performed. A restart can also be 
performed by simply cycling power to the recorder.
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Task 
18

Make a uSb deVice Port connection

acceSSing the recorder Via itS uSb deVice Port
The previous tasks have assumed that you would access the recorder via its serial Terminal Port. A mo‑
dem‑based connection is used in a similar manner. A third method can be used to access the recorder. 
It utilizes the USB Device Port which is located on the top panel of the recorder. Like the other access 
methods, HyperTerminal can be used to control the connection and provide the user interface environ‑
ment. A USB connection provides one very distinct advantage. It is very fast. You may elect to use this 
method when Dumping large numbers of Event Records to a PC file. The Query command Dump feature 
is described in Task 10.

before you Start
Your PC must have HyperTerminal installed and ready for use. You should be familiar with the steps nec‑
essary to launch your Windows operating system and log on as a user. You should also be familiar with 
basic Windows operations, such as selecting commands and using the mouse.

This task describes how to establish a high speed USB‑based connection between your recorder and 
PC. To take advantage of this method, your PC will require that specific drivers and related software 
be installed and running. The installation of this software is outside the scope of this guide. However, the 
procedure for doing so is fully described in Appendix D of the Metra‑version CWR‑72E User Manual. A PDF 
copy of this document can be downloaded from the following web page. 
www.micro‑aide.com/support/documentation.html

The required PC software is available for downloading from: 
www.micro‑aide.com/support/downloads.html

The required software is titled “USB Drivers”. For the remainder of this task it is presumed that the USB 
Device Port software is installed and running within your PC. A USB type A‑B cable will also be required.

what to do
We’ll begin by creating a new USB‑based connection specifically for your CWR recorder. We’ll then set 
terminal emulation for the connection. Perform the steps listed in each section in the order given.

creating a new uSb connection
1. Use the USB type A‑B cable to connect the recorder’s USB Device Port to a spare USB port on the PC.

Since the appropriate driver software has already been installed, you can ignore any Windows messages 
regarding the new USB connection.

2. Using your mouse, click in the lower left‑hand corner of your desktop in the area labeled “Start”. Then 
click in the area labeled “All Programs”.

3. Click on the folder labeled “HyperTerminal” to expand it.

4. Click the sub‑list item labeled “HyperTerminal”. After a short delay the following dialog box labeled 
“Connection Description” will appear.

http://www.micro-aide.com/support/documentation.html
http://www.micro-aide.com/support/downloads.html
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 HyperTerminal – New Connection Dialog Box

5. In the edit box labeled “Name:” enter a label that identifies the new connection. As an example, 
type D�undee USB. Click the button labeled “OK”. The following dialog box named “Connect To” will 
appear.

 HyperTerminal – Connect To Dialog Box

6. Click the down arrow at the right edge of the drop‑down list box labeled “Connect using:”. Select 
the newly created comm port (e.g., “Com17”).

The term “newly created comm port” refers to the port created when the USB driver software was in‑
stalled.

7. Click the button labeled “OK” to accept the new comm port assignment.

A new HyperTerminal connection has been created. It is now necessary to assign the correct emulation 
for the connection.

Setting the eMulation
8. After selecting the comm port for the new connection the dialog box named “Com Properties” will 

be displayed. An example is shown in the following. Your dialog box will actually be labeled with the 
comm port number you selected earlier.
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 HyperTerminal – Com Properties Dialog Box

9. Click the button labeled “Cancel”. A blank HyperTerminal window will appear.

Baud rate and bit coding settings do not apply to USB‑based connections.

10. Click on the command named “File”. It is located in the menu bar at the top of the HyperTerminal 
window. Click on the sub‑command named “Properties”. A dialog box labeled “Dundee USB 
Properties” will be displayed.

11. At the top of the dialog box click the tab labeled “Settings”. A dialog box similar to the following will 
be displayed.

HyperTerminal – Com Properties Dialog Box

12. Modify the various settings to match those listed in the previous screen. Make sure that the drop‑
down list box labeled “Emulation:” is set to “ANSI”.

13. Double check everything. If all the settings are correct click the button labeled “OK”.

14. The menu bar is located along the top of the HyperTerminal window. Click the command named 
“File” and then the sub‑command named “Save”.
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Your PC now has a newly defined comm port connection that is tailored for this specific recorder. 
To launch the new connection simply click the icon labeled “Dundee USB.ht” that exists within the 
HyperTerminal Connections folder.

For easy access, you may wish to create a shortcut for the “Dundee USB” connection and place it on 
your Windows desktop.

creating connectionS for additional recorderS.
The serial port comm connection created in Task 1 can be used with any recorder whose Terminal 
Port is set to operate at the same Baud rate. Conversely, the modem connection created in Task 2 
can only be used to access the recorder at a specific telephone number. Nevertheless, the modem’s 
various settings can be used to create a new connection whose only difference is the telephone num‑
ber.

The USB Device Port of every recorder is identified with uniquely coded information. For this reason, when 
you connect your PC to the USB Device Port of another recorder a new connection must be created. 
The only difference is that a different comm port will need to be assigned to the new connection. This 
can be done by simply selecting a new comm port number (e.g., Com18) in step 6 of the previous pro‑
cedure. Remember to save the new connection with a different name (e.g., Central Ave).

When creating USB connections for additional recorders it is not necessary to install the USB driver soft‑
ware once again. The drivers only need to be installed once.

log on uSing the uSb deVice Port
The log on procedure used with the USB Device Port is similar to that used with the Terminal Port. The pro‑
cedure can be performed as follows.

1. Use the USB type A‑B cable to connect the recorder’s USB Device Port to a spare USB port on the PC.

2. Launch the appropriate, and previously created, HyperTerminal connection for this recorder. The up‑
per left‑hand corner of the HyperTerminal window should appear as shown in the following. Note the 
yellow phone icon that is in the up position. This indicates that a connection is active.

HyperTerminal – Active USB Connection

3. Press the Enter key. A Password challenge will be issued. Enter the appropriate Password to com‑
plete the Log On.

The USB Device Port utilizes a hardware interface that is substantially different than that used by the 
Terminal Port. The recorder cannot automatically determine if a device, like a PC, is connected to its 
port. Accordingly, the Password challenge is not issued when the connection is first established. It occurs 
only after a key is pressed and read by the recorder.

For security reasons, always disconnect the USB type A‑B cable from the recorder when the current user 
session has been terminated.
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Task 
19

add failed laMP detection to the SySteM

introduction to the fld‑2
The Metra Recording System must include the ability to detect and report the failure of one or more 
lamps at a crossing. The FLD‑2 was also designed to meet the following additional requirements.

•	 Either incandescent or halogen lamps will be used (as opposed LED devices).

•	 The flash rate of the lamp circuit, while active, must be reported by the recorder.

•	 An EOR relay will not be available at installations equipped with a Safetran SSCC.

This task is only informative in nature. Before describing tasks that target specific behavior of the FLD‑2, it 
is best to summarize the purpose of the unit and how it contributes to the capabilities of the system as a 
whole. This task and the two succeeding tasks are not intended to replace or duplicate content includ‑
ed within the FLD‑2 User Manual. Rather, its purpose is to provide a concise and targeted description of 
how to use the FLD‑2 effectively.

inStallation SuMMary

connectionS to the laMP circuitS
The FLD‑2 monitors lamp current in each leg of the circuit as opposed to monitoring only the current in 
the common return path. By using separate, dual sensors the FLD‑2 is able to discern each current pulse 
in both legs of a circuit.

The current carrying conductors of a typical lamp circuit are inserted through appropriate holes in the 
FLD‑2. This wiring method is illustrated in Figure 6 on page 70. The FLD‑2 is equipped with two sepa‑
rate circuits. They are referred to as EN1‑EB1 and EN2‑EB2. A maximum of 12 lamps can be monitored 
per circuit. Both circuits sense current independently of the other. Their separate outputs allow them to 
independently report light out conditions and flash pulsing. Their operating parameters are calibrated 
separately.

connectionS to the recorder
Specific connections must also be made between the recorder and FLD‑2. These connections are il‑
lustrated in Figure 7 on page 70. The outputs of the FLD‑2 are available on detachable, tension clamp 
connectors located along the unit’s top panel. The FLD‑2 to recorder connections are listed by silk‑
screened labels and assigned Input Names in Table 10 on page 71.

The wiring assignments must not be modified. They are strictly imposed by the Metra‑defined Setup 
Databases. 
 
The larger Digital Input capacity of the CWR‑72E allows it to support two FLD‑2 units. The lower portion of 
Table 10 lists the additional assignments which may on occasion be required.

Additionally, the crossing’s XR relay must be wired to the FLD‑2. The XR is used by the FLD‑2 to indicate 
when a check of the lamp current can be initiated. A precise measurement of each lamp current is 
made shortly after the XR goes active. The duration of the current measurement allows the current to 
stabilize and yield a consistent reading.
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Typical FLD‑2 Lamp Circuit Wiring

Figure 7: 

1 2 3 4
ON

DC-On / AC-OffOut2Out1In
Always On

PB2

LED2

PB1

LED1FPLOFPLOXR2XR1

Power

Halogen-On /
Incand.-Off

D24 - Flash Rate 2

D23 - Light Out 2

D22 - Flash Rate 1

D21 - Light Out 1

XR Circuit 2

XR Circuit 1

FLD‑2 to Event Recorder Wiring
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1st 
FLD�-2

CWR-40E & CWR-72E
D�igital Input Number Input Name

LO1 D21 LIGHT OUT 1
FP1 D22 FLASH RATE 1
LO2 D23 LIGHT OUT 2
FP2 D24 FLASH RATE 2

2nd 
FLD�-2

CWR-72E Only
D�igital Input Number Input Name

LO1 D53 LIGHT OUT 3
FP1 D54 FLASH RATE 3
LO2 D55 LIGHT OUT 4
FP2 D56 FLASH RATE 4

Table 10: Setup Database Assignments
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Task 
20

calibrate the fld‑2

calibrating for a Single laMP failure
The FLD‑2 utilizes a microprocessor‑based, all digital design to precisely measure lamp current. The 
outputs of the four current sensors are scanned and their samples are immediately converted to numeri‑
cal values. The microprocessor firmware then analyzes the data to determine if a failure has occurred. 
However, this check cannot be performed accurately until such time as the FLD‑2 is fully calibrated.

before you Start
This task presumes that the FLD‑2 is properly installed, wired and powered on as described in Task 19. A 
PC is not required to complete the task.

what to do
The FLD‑2 calibration procedure consists of three parts. It requires that the crossing be activated at least 
twice and that one lamp be removed. For this reason it is recommended that you perform this proce‑
dure while traffic is lighter than usual.

Setting the configuration SwitcheS
As illustrated in Figure 8, the top panel of the FLD‑2 includes a four‑position DIP switch assembly.

Figure 8: 

1 2 3 4
ON

DC-On / AC-OffOut2Out1In
Always On

PB2

LED2

PB1

LED1FPLOFPLOXR2XR1

Power

Halogen-On /
Incand.-Off

Top Panel View of the FLD‑2

The four individual switches select various operating modes as detailed in Table 11 on page 74. Switch 
positions SW‑1 and SW‑2 control the type of lamp used by circuits 1 and 2, respectively. Switch position 
SW‑3 provides for either AC or DC lamp current.

Switch SW‑4 must never be set to the off (up) position.
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Lamp Type Current SW-1 SW-2 SW-3 SW-4

Halogen DC On On On On 1 2 3 4
ON

Incandescent DC Off Off On On 1 2 3 4
ON

Halogen AC On On Off On 1 2 3 4
ON

Incandescent AC Off Off Off On 1 2 3 4
ON

Table 11: Switch Settings

calibration with all laMPS flaShing
The following procedure requires that all lamps be installed in both the EB and EN sides of the lamp cir‑
cuit. Figure 9 on page 75 illustrates the sequence of steps and observations that comprise this portion 
of the calibration procedure.

1. Briefly press and then release the pushbutton switch labeled “PB1”. Verify that the indicator labeled 
“LED1” is blinking approximately once per second.

2. Manually activate the crossing. LED1 will continue to blink.

3. Verify that all of the crossing lamps are flashing properly and that the tip lamp is on. After one second 
the FLD‑2 will validate the XR1 input. LED1 will then be on, but not blinking.

4. Wait approximately 10 seconds. LED1 will turn off automatically. This indicates that the FLD‑2 has cali‑
brated a reading for the first of its two circuits.

5. Deactivate the crossing. This portion of the procedure has been completed.

calibration with one failed laMP
The FLD‑2 takes separate current readings from the EB and EN sides of the lamp circuit. Accordingly, this 
portion of the calibration procedure requires that one lamp be removed from each side. After calibra‑
tion, the FLD‑2 will be able to detect the occurrence of a single lamp failure from either side. Figure 10 on 
page 76 illustrates the sequence of steps and observations that comprise this portion of the calibration 
procedure.

1. Disconnect two flashing lamps (i.e., not a tip lamp), one each from the EB and EN sides of the lamp 
circuit.

2. Briefly press and then release twice in rapid succession the pushbutton switch labeled “PB1”. Verify 
that the indicator labeled “LED1” is blinking approximately twice per second.

3. Manually activate the crossing. LED1 will continue to blink.

4. Verify that only the disconnected lamps are not flashing. After one second the FLD‑2 will validate the 
XR1 input. LED1 will then be on, but not blinking.

5. Wait approximately 10 seconds. LED1 will turn off automatically. This indicates that the FLD‑2 has cali‑
brated a single lamp failure reading for the first of its two lamp circuits.

6. Deactivate the crossing. The procedure has been completed.

If required, repeat the two portions of the calibration procedure for the second lamp circuit. The labels 
“PB2”, “LED2” and “XR2” will apply.
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Either portion of the calibration procedure starts when the appropriate PB switch is pressed. To immedi‑
ately terminate the sequence, press the PB switch once prior to the validation of the XR input. The LED will 
stop blinking and the FLD‑2 will return to its normal operation. 
 
MICRO‑AIDE recommends that the calibration procedure also be performed whenever lamps are re‑
placed or changes are made to any of the lamp control systems.

Figure 9: 
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Figure 10: 
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Task 
21

oPerate the fld‑2

acceSSing and interPreting fld‑2 baSed data
Operating the Event Recorder is largely a matter of accessing and understanding the information it pro‑
vides. The same is true of the FLD‑2. Like the recorder, the FLD‑2 operates automatically without the need 
for user intervention once it has been properly configured. Unlike the recorder, the information it provides 
is not directly accessible. The information it provides is discerned by the recorder from the FLD‑2 Light Out 
(LO) and Flash Pulse (FP) outputs. In summary, operating the FLD‑2 consists of looking at Event Record 
data from inputs of the Event Recorder that are connected to outputs of the FLD‑2.

before you Start
The primary purpose of this task is to provide useful information to the user. This task draws attention spe‑
cifically to Event Record data that pertains to the operation of the FLD‑2. A more comprehensive expla‑
nation of Event Record content can be found in Task 13 entitled “Event Record Formatting Options”.

Sample records are listed throughout this task. However, if the user wishes to review actual Event 
Records, a PC running HyperTerminal will have to be connected to the recorder. The first four tasks of this 
guide explain how to prepare your PC and log on. Additionally, several Event Records from the LIGHT 
OUT and FLASH RATE Digital Inputs will have to be saved in the memory of the recorder.

oPeration of the lo and fP outPutS
The FLD‑2 can only interact with the Event Recorder via its LO and FP outputs. The operation of these 
outputs is described in the following. Table 10 on page 71 details the connections made between the 
FLD‑2 outputs and Digital Inputs of the recorder. The Metra‑defined Setup Databases are responsible for 
these assignments.

LO – The Light Out output is connected to a LIGHT OUT Digital Input of the recorder. This signal assumes an 
On state when the crossing is active and the FLD‑2 has determined that one or more lamps have failed. 
The LO returns to its Off state when the crossing is once again idle. It follows that any Event Record from a 
LIGHT OUT input should be investigated. Furthermore, a failure will be reported via an Event Record each 
time the crossing is activated, provided the lamp continues to fail.

LED1 and LED2 are also used to indicate lamp failures. The LEDs follow the activity of LO output as illus‑
trated in Figure 11 on page 78.

FP – The Flash Pulse output is connected to a FLASH RATE input of the recorder. This signal pulses high and 
low in sync with the flash rate of the lamps. It operates much like an EOR relay would in the case of a 
relay‑based crossing system. The recorder uses the FP signal to create Event Records that mark the start 
and end of each flashing sequence. The end or Off Event Record includes a field that reports the aver‑
age flash rate while the crossing was active.

Figure 12 on page 78 illustrates the pulsing nature of the FP output while the crossing is active and the 
lamps are flashing.
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Figure 11: 
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Figure 13 shows two Event Records that include information derived from an FLD‑2. The first record reports 
a typical flash rate. The second record indicates a lamp failure.
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Task 
22

inStall the gea Software

gea inStallation Procedure
MICRO‑AIDE’s Graphical Event Analyzer (GEA) software can be used to access, save, review and plot 
Event Record data from a variety of MICRO‑AIDE recording devices. However, the focus of our attention 
will be limited to how GEA can be used with the Metra Event Recorders.

GEA features an easy‑to‑use point and click user interface and will run on any commonly used Windows 
PC. Its features and capabilities will be the subject of the remaining tasks in this guide. We’ll start by learn‑
ing how to install GEA.

getting the lateSt VerSion of gea
You’ll need the latest version of the GEA software which can always be downloaded at: 
www.micro‑aide.com/support/downloads.html

Save the downloaded GEA software to a convenient location such as your desktop. The downloaded 
file will be a zip file with a .zip extension.

At the present time the latest version of GEA is 3.11 and the downloadable file is named gea_v311.zip.

before you Start
The GEA software is supported by a separate User Manual that includes additional information. This guide 
is not intended to be a substitute for the User Manual. A PDF copy of the manual can be downloaded at: 
www.micro‑aide.com/support/documentation.html

It is important to note that the latest version of GEA is always designed to work with the latest version of 
the Event Recorder firmware. For this reason, before installing GEA it is advisable to visit the MICRO‑AIDE 
website and verify that your Event Recorders are running the current firmware.

As with any application, in order to install GEA you will need to log on to your PC as an administrator. If 
this is not possible you will have to contact a responsible member of the Metra I.T. department.

Lastly, if you already installed GEA on your PC and it is not version 3.11, it must be uninstalled. Older 
versions of GEA must always be uninstalled before a newer version can be installed. The GEA uninstall 
procedure is described in the section entitled “Uninstalling GEA” on page 83.

what to do
To install GEA perform each of the steps listed in the following section.

1. Navigate to your desktop or folder where you saved the gea_v311.zip file. Double‑click on the zip file. 
It will list an executable file named SetupGEA311.exe. Double‑click the .exe file. A dialog box similar 
to the following may be displayed. If not, skip the next step.

http://www.micro-aide.com/support/downloads.html
http://www.micro-aide.com/support/documentation.html


Metra training guide

80 Micro‑Aide

22

2. Click the button labeled “Run”. The following dialog box will be displayed.

3. Click the button labeled “Next>” to display the following dialog box.

4. Accept the default folder location to install GEA by clicking the button labeled “Next>”. The following 
dialog box will be displayed.
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5. Accept the default folder name by clicking the button labeled “Next>”. The following dialog box will 
be displayed.

6. Click the button labeled “Next>” to proceed with the installation. The following dialog box will be 
displayed. It notes the progress of the installation. It will close automatically within a few seconds.

7. The installation of the GEA files has now been completed. The following dialog box will be displayed.
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The Lantronix Redirector software must not be installed. The Metra recording system does not require its 
use.

8. Click the button labeled “Cancel” to ignore this option. The following dialog box will be displayed

9. Click the button labeled “Finish”. The following and final dialog box will be displayed.
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10. As the final step in this procedure click the button labeled “OK” to close the dialog box. GEA is now 
fully installed and ready for use.

An icon named GEA will be added to your PC’s desktop. It can be double‑clicked at any time to launch 
GEA.

uninStalling gea
If an older version of GEA is presently installed on your PC it must be removed prior to installing a new ver‑
sion. Likewise, if you wish to reinstall the existing version it must first be uninstalled. The uninstall procedure 
is described in the following steps.

1. Using your mouse, click in the lower left‑hand corner of your desktop in the area labeled “Start”. Then 
click in the area labeled “All Programs”.

2. Click on the folder labeled “GEA” to expand it.

3. Click the sub‑list item labeled “Uninstall GEA”. After a short delay the following dialog box will be 
displayed.

4. Click the button labeled “Yes” to proceed with the removal. As the removal takes place the follow‑
ing dialog box will be displayed. The removal will only take a few seconds.

5. Click the button labeled “OK” to complete this procedure.

Uninstalling GEA will not remove any previously saved Event Record data or plot templates. The entire 
contents of the GEA Recorder Data folder will remain unaltered as a result of this procedure.
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Task 
23

configure gea

aSSigning the gea SySteM ParaMeterS
Two things must be done before GEA can be used with your Event Recorders. A few system level param‑
eters must be assigned. As their name implies these parameters apply to the GEA software as a whole. 
Assigning these parameters configures GEA to then accept recorder‑specific parameters that it will use 
when accessing recorders as you direct. Assigning recorder‑specific parameters is the subject of the next 
task.

before you Start
You should be familiar with the steps necessary to launch your Windows operating system and log on as 
a user. You should also be familiar with basic Windows operations, such as selecting commands and us‑
ing the mouse. To complete this task GEA must be properly installed on your PC.

what to do
To assign the system‑level parameters that will configure GEA perform each of the following steps.

1. Before you launch GEA you must create a new folder referred to as the Main GEA Data Folder. This 
folder will serve as the container for other sub‑folders and files that will be created for each Event 
Recorder that GEA will access. The Main GEA Data Folder will not be used by other applications.

Create the new folder by right‑clicking on an empty space in your desktop. A context menu of sev‑
eral commands will appear. Click the command labeled “New > Folder”. A folder identified as “New 
folder” will appear on your desktop. Rename the folder “GEA Recorder Data”.

The Main GEA Data Folder can be named differently and located elsewhere; however, the user is strong‑
ly encouraged to accept the folder definition used throughout this guide. Throughout the remainder of 
this guide a folder name of “GEA Recorder Data” will be used. The various screens included in the guide 
will depict the GEA Recorder Data folder located on the desktop.

2. Launch GEA by double‑clicking the GEA desktop icon. Assuming you have not previously used GEA, 
a dialog box similar to the following will be displayed.

3. Click the button labeled “OK” to close the dialog box and proceed. Assuming that GEA has not 
been previously launched, the following dialog box will be displayed. If GEA has been launched pre‑
viously, it can be displayed by selecting the GEA command named “Edit > Properties”.
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Edit Properties Command

4. In the top section of the dialog box are four drop‑down list boxes. The box labeled “Direct Port:” 
should be assigned the comm number of the PC’s serial comm port. The Baud rate should be left as 
38400. The modem settings are only useful once telephone lines are made available to the crossing 
sites.

5. Click the button labeled “Browse”. A dialog box similar to the following will be displayed.

Select the GEA Recorder Data Folder

6. Navigate to and select the GEA Recorder Data folder previously created in step 1. Click the button 
labeled “OK”. The folder that will serve as the Main GEA Data Folder has now been identified. The 
GEA Properties dialog box will once again be displayed.

7. If not already enabled, click the radio button labeled “Prompt to Delete files older than 30 days”. 
With time, GEA will save many Event Record data files. This setting will prompt the user before delet‑
ing files that are older than 30 days. Click one of the other two radio buttons in this group if you prefer 
another setting for the file delete feature.

8. It is assumed that GEA will use a serial comm port to access various Event Recorders. In the block 
labeled “Preferred Connection for Polling” select the setting labeled “Direct”.

9. The checkbox labeled “Synchronize Recorder Clock to PC” must be left blank (i.e., not checked).
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It is critically important that the Synchronize Recorder Clock to PC feature be disabled. If enabled, it will 
conflict with the GPS Receiver clock sync option that Metra has selected.

10. Click the checkbox labeled “Use .TXT file for reports”. Once enabled, this feature forces GEA to use 
Notepad to create simple text files when Event Record data and the Setup Database need to be 
reviewed by the user.

11. After all of the settings have been verified as correct, close the dialog box by clicking the button 
labeled “OK”. The main GEA window will be displayed.

You can now add a list of Event Recorders that GEA will access. This is the subject of the next task.
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Task 
24

create the gea liSt of recorderS 

identifying eVent recorderS gea will acceSS
In any given Metra district you may be responsible for several different crossings. Each crossing will be 
equipped with a similar, but not identical Event Recorder. Each recorder will be identified with a unique 
Unit Name. If you intend to use GEA to retrieve Event Record data and to review and plot that data, 
GEA will need specific information for each recorder. The GEA list of recorders is nothing more than an 
organized list of recorder‑specific information that tells GEA how to access and save recorder data.

before you Start
You should be familiar with the steps necessary to launch your Windows operating system and log on as 
a user. You should also be familiar with basic Windows operations, such as selecting commands and us‑
ing the mouse. To complete this task GEA must be properly installed on your PC and the Main GEA Data 
Folder must be assigned and named GEA Recorder Data.

what to do
To create a list of GEA accessible recorders perform each of the steps listed in the following section.

1. Begin by launching GEA. This can be done by double‑clicking the GEA icon on your desktop. The 
following GEA window will be displayed. The center section of the window is presently empty. It will 
eventually contain a list of accessible recorders.

GEA Window – Shown Empty

2. Click the button labeled “Add”. The following dialog box will be displayed.
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Add Recorder Dialog Box – Empty

3. Add a recorder to the list by filling in the edit box labeled “Recorder ID:”. This edit box must match the 
first 20 characters of the recorder’s Unit Name. Unit Names are the subject of Task 5.

It is absolutely imperative, for reasons that will be discussed later, that the GEA Recorder ID match the first 
20 characters of the recorder’s assigned Unit Name.

4. Click the drop‑down list box labeled “Type:”. From the list of recording devices select the entry la‑
beled “CWR‑72E”.

5. The setting for the drop‑down list box labeled “Direct port:” can be left as “Default Port”. The Default 
Port is the comm port assigned as part of the GEA Properties group.

6. Since you will not be accessing your recorder via a modem, the edit box labeled “Phone#:” can be 
left blank.

7. In the edit box labeled “Password:” type SIGNAL. The recorder’s Administrative Password can be 
used as well. The asterisk (*) character is used to hide the assigned Password.

8. The edit box labeled “Checksum:” should be assigned either of two values. If the recorder is running 
V1.01 firmware, use a checksum value of 19B4. If version 1.02 firmware is being used, enter a value of 
68D�6. Checksum values are not case‑sensitive.

At the time this guide was written V1.01 firmware was installed in every recorder. However, V1.02 was 
available for installation.

9. Click the drop‑down list box directly underneath the label “Position 1”. Select the “2048K” entry. 
Leave the other drop‑down list boxes in this group unassigned.

10. The following screen depicts a typical Add Recorder dialog box after it has been completed.

Add Recorder Dialog Box – Typical Example

11. If everything appears to be correct, click the button labeled “OK” to close the dialog box and return 
to the GEA window.
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12. The GEA window will now include a single entry in its list of recorders. An example is shown in the fol‑
lowing.

 GEA Window – Typical Recorder Entry

This task has been completed. You may wish to exit GEA at this time. If you elect to do so, click the 
“File > Exit” command. Select the “Yes” option to close the GEA application.

related featureS

add another recorder
To add additional recorders to the list, simply click the button labeled “Add” as you did in step 2 of the 
previous procedure. An empty Add Recorder dialog box will be displayed. Fill‑in its contents as previously 
described. The new recorder entry will be added to the bottom of the list.

delete an exiSting recorder
If you have accidently added a recorder entry or would like to remove an entry, perform the following 
steps.

1. With your mouse, click the entry to be deleted. The entry will be highlighted with a blue background.

2. Click the button labeled “Delete”. The entry is immediately removed from the list.

When a recorder is added to the list, GEA immediately creates a sub‑folder in its Main GEA Data Folder 
specifically for that recorder. Deleting a recorder from the list does not delete its sub‑folder nor its con‑
tents. If the user wishes to remove the sub‑folder, this must be done using Windows Explorer. When doing 
so, be careful to remove the correct sub‑folder and only after the recorder has been deleted.

edit an exiSting recorder
The various settings of an existing recorder entry can be changed by performing the following steps.

1. With your mouse, click the entry to be edited. The entry will be highlighted with a blue background.

2. Click the button labeled “Edit”. A dialog box labeled “Edit Recorder” will be displayed. Alter any of 
the settings as required. Click the button labeled “OK” to accept the new settings.
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change the liSt ordering
The list of recorders will include the first recorder added at the top and the most recent recorder added 
at the bottom. You may wish to change the order by geographical proximity or alphabetize it. The posi‑
tion of any single entry can be moved by performing the steps listed in the following.

1. With your mouse, click the entry to be moved. The entry will be highlighted with a blue background.

2. Click the button labeled “Move”. The entry’s highlight will disappear.

3. Click the position in the list where the selected recorder will now be positioned. For example, to make 
it the fourth recorder in the list, click the existing fourth entry from the top. The remaining recorders will 
be relocated downward by one position .

Repeat these steps to reorder other portions of the list.
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Task 
25

acceSS a recorder and itS SetuP databaSe

download and reView the SetuP databaSe
Before GEA can acquire data from an Event Recorder it must be able to access it via a communication 
pathway. This task demonstrates a simple method of verifying that GEA can communicate with a se‑
lected recorder. The various reports and plots that GEA can create are all contingent upon GEA having 
a copy of the Setup Database used by the recorder. This task will also describe the procedure for getting 
the Setup Database.

before you Start
You should be familiar with the steps necessary to launch your Windows operating system and log on 
as a user. You should also be familiar with basic Windows operations, such as selecting commands and 
using the mouse. To complete this task GEA must be properly installed on your PC. At least one recorder 
must be listed in the GEA window.

Launch GEA by double‑clicking its desktop icon. Connect the MICRO‑AIDE provided one‑to‑one cable 
to the appropriate comm port of the PC and the Terminal Port of the recorder you wish to access.

what to do

Verifying acceSSibility
The following procedure allows you to verify that GEA can communicate with a recorder of your choice.

1. A screen similar to the following should be displayed.

GEA Window – Typical Recorder Entry

2. Click the list entry of the recorder you wish to access. The entry will be highlighted in blue. Click the 
“Access > Connect > Direct” command. After a few seconds the following GEATerm window will be 
displayed.
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GEATerm Window

3. GEATerm allows the user to interact with the recorder. However, it is not intended to be a substitute 
for HyperTerminal. After entering a Password the Main Menu of recorder commands will be displayed.

4. Terminate the GEATerm session by closing the window or pressing the Alt and F4 keys simultaneously.

Interacting with the recorder via GEATerm verifies that the comm port and Baud rate for the recorder are 
correctly assigned within GEA. You may wish to use this procedure on other recorders in the list.

downloading the SetuP databaSe
GEA can be used to retrieve, review and plot Event Record data. However, these capabilities require 
that GEA have access to a copy of each recorder’s Setup Database. The following procedure must be 
used to access and save each recorder’s database.

As previously explained, it is imperative that this procedure be performed before proceeding further.

1. Click the list entry of the recorder you wish to access. The entry will be highlighted in blue. Click the 
“Access > Download Setup Data > Direct” command.

2. GEA will proceed to establish communications with the selected recorder. Using the assigned 
Password, it will log on. GEA will then issue a series of commands allowing it to retrieve the Setup 
Database. GEA will save it as a binary file within a sub‑folder of the Main GEA Data Folder. The sub‑
folder will be uniquely associated with and named after the selected recorder.

3. As shown in the following example, the status bar at the bottom of the GEA window is used to indi‑
cate the progress of the download.

Status Bar Indicating Successful Retrieval
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This procedure must be performed for each entry in the GEA list of recorders.

reView the SetuP databaSe
GEA now has access to each recorder’s Setup Database. The following procedure allows you to review 
the database by using your PC’s Notepad application.

1. Click the list entry of the recorder you wish to access. The entry will be highlighted in blue. Click the 
“View > Recorder Setup Data” command. 

2. A text file named “setupdata.txt” will be opened in Notepad. The file will contain the entire contents 
of the Setup Database just as if it were accessed directly from the recorder.

3. Close the Notepad window when you are done reviewing the file.

When the setupdata.txt file is first opened in Notepad, it is automatically saved to the selected recorder’s 
sub‑folder. This allows you to read the file at any time without launching GEA.

related featureS

edit the SetuP databaSe
The “Edit > Edit Recorder Setup Data” command can be used to alter the contents of the recorder’s 
Setup Database. The procedure for doing so is fully explained in Chapter 4 of the GEA User Manual. the 
chapter is entitled “Preparing the Setup Database”.

Metra has defined three Setup Databases for use with the Event Recorders. These databases must not be 
altered. A new database should only be required by a special application or temporary test.

uPload the SetuP databaSe
If a recorder’s Setup Database (BEV, MED or Mainline) is corrupted, it can be restored by using GEA. 
However, before doing so it is important to verify that GEA is using an unaltered version of one of the 
three Metra‑defined databases. The “Access > Upload Setup Data > Direct” command is used to perform 
the restoration. Since restoring a Setup Database overwrites the existing database, an Administrative 
Access session is required. This can only be accomplished if the recorder entry in the list includes the 
Administrative Password rather than the Restricted Password cited in the previous descriptions. The up‑
load will fail if the Administrative Password is not used by GEA.

The procedure for restoring the Setup Database using HyperTerminal is the subject of Task 18.
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Task 
26

View inPut StatuS and today’S recordS

acceSSing baSic data froM the recorder
GEA includes features that provide many different ways to access and review data from your recorders. 
The complexity of these features varies from the very simple (e.g., single mouse click) to the more sophis‑
ticated that require user input. This task describes the basic methods of getting and viewing data. It will 
serve as an introduction to the more specialized and powerful methods described in the next task.

before you Start
You should be familiar with the steps necessary to launch your Windows operating system and log on 
as a user. You should also be familiar with basic Windows operations, such as selecting commands and 
using the mouse. To complete this task GEA must be properly installed on your PC. At least one recorder 
must be listed in the GEA window. A partial day’s worth of Event Records from the current date should 
be saved in the recorder. This will allow the reader to follow the second lesson cited in this task. Finally, 
the Setup Database for each recorder must be saved. The latter is the subject of Task 25.

Launch GEA by double‑clicking its desktop icon. Connect the MICRO‑AIDE provided one‑to‑one cable 
to the appropriate comm port of the PC and the Terminal Port of the recorder you wish to access.

what to do

Viewing real‑tiMe StatuS
Task 14 entitled “Live Status Views” described how the real‑time status of each Digital and Analog 
Input could be viewed in a HyperTerminal window. GEA includes a similar feature that is graphical in na‑
ture rather than text based. To view the real‑time status of each input, click the “Access > Status >Direct” 
command. After a delay of several seconds a screen similar to the following will be displayed.
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GEA Live Status

The Live Status screen simulates an array of LEDs. There is one LED per Digital, Analog and Virtual Input. 
Virtual Inputs can be ignored as they are not defined by any of the Metra Setup Databases. The simu‑
lated LEDs illuminate in accordance with the following rules.

D�igital Inputs – If the input is On (adequate voltage is applied to its terminals) the LED is bright green. 
For example, D1 is On. If the input is Off (no voltage is applied to its terminals) the LED is dark green. For 
example D3 is Off.

Analog Inputs – If the input voltage is within its acceptable range of operation the LED is dark green. For 
example, A1 is within its acceptable range of operation. If the input voltage is outside its acceptable 
range of operation the LED is red. For example, A6 is outside its acceptable range of operation. The pres‑
ent voltage is also reported for each Analog Input.

The Live Status screen will update automatically as the status changes. Additional information regarding 
each input can be viewed by performing the steps described in the following section.

D�igital Inputs – With your mouse, right‑click the Input Number of any Digital Input (e.g., D17). Data similar 
to the following will be displayed.

Input Properties – Digital Input

The data includes all of the Setup Database information for the selected input.
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Analog Inputs – With your mouse, right‑click the Input Number of any Analog Input (e.g., A8). Data similar 
to the following will be displayed.

Input Properties – Analog Input

The data includes all of the Setup Database information for the selected input.

getting eVent recordS froM today
Another simple command allows GEA to acquire all of the Event Records for the current day. The resul‑
tant file will include Event Records from midnight (i.e., 00:00:00) through the current time. 

1. Click the list entry of the recorder you wish to access. The entry will be highlighted in blue. Click the 
“Access > Poll Todays Data > Direct” command.

2. GEA will proceed to establish communications with the selected recorder. Using the assigned 
Password, it will log on. GEA will then issue a series of commands allowing it to retrieve the requested 
data. GEA will save it as a binary file within a sub‑folder of the Main GEA Data Folder. The sub‑folder 
will be uniquely associated with and named after the selected recorder.

3. As shown in the following example, the status bar at the bottom of the GEA window is used to indi‑
cate the progress of the download.

Status Bar Indicating Successful Retrieval

View eVent recordS
The previous exercise will create a binary Event Record file that will be saved within a sub‑folder of the 
Main GEA Data Folder. The sub‑folder is named after the selected recorder that was polled. The user is 
unable to view the highly compressed, binary Event Record file directly. However, a GEA command can 
be used to convert it into a readable text document.

1. Click the list entry of the recorder you wish to access. The entry will be highlighted in blue. Click the 
“View > Recorder Event Records” command. A screen similar to the following will be displayed.
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Open File Dialog Box

2. The dialog box displays the contents of the sub‑folder named “DIST_SUBDR_XING‑NAME”. The sub‑
folder contains a binary Event Record file named “110911‑183919.bin”. This is the file that the Poll 
Todays Data command created. The filename is in the form YYMMDD‑hhmmss.bin, where the date 
and time reflect when the file was saved.

3. In the sample screen previously cited only one Event Record file is shown. Over time, many files will 
likely be saved to the sub‑folder. Select the file you wish to view by clicking its filename. Click the 
button labeled “Open”. A screen similar to the following will be displayed. The following list of Input 
Names is from the Mainline Setup Database.

Query Select Inputs Dialog Box

4. To view records from every input, click the button labeled “OK”. To view records from specific inputs, 
click those inputs in the list. Use the normal Windows techniques of Shift and Ctrl clicking to select 
contiguous and non‑contiguous ranges, respectively. Click the button labeled “OK” when you are 
done selecting inputs.

5. The Event Records will be displayed in an open Notepad file. The document will always be assigned a 
filename of “Events.txt”. A small excerpt from a typical Events.txt file is shown in the following screen.
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Typical Events.txt Report

6. The file can be renamed and saved in any location the user desires. The Event Records are always 
reported using the single‑line record format. Event Record formatting and content options are de‑
scribed in Task 13.
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uSer noteS
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Task 
27

acceSS Selected eVent record data

Querying a Selected interVal
The previous task described a method by which the current day’s Event Records could be acquired and 
viewed as text. This task will describe a method that allows you to acquire record data that spans any 
range of times and dates. This method is referred to as the Query Selected Interval method.

Pay careful attention to the details of this task. It describes the method you will use in many cases to get 
Event Record data from the recorder that you will later read, plot and analyze.

before you Start
You should be familiar with the steps necessary to launch your Windows operating system and log on 
as a user. You should also be familiar with basic Windows operations, such as selecting commands and 
using the mouse. To complete this task GEA must be properly installed on your PC. At least one recorder 
must be listed in the GEA window. To follow the example cited in this task, it is helpful if the recorder 
contains record data spanning two or more days. Finally, the Setup Database for each recorder must be 
saved. The latter is the subject of Task 25.

Launch GEA by double‑clicking its desktop icon. Connect the MICRO‑AIDE provided one‑to‑one cable 
to the appropriate comm port of the PC and the Terminal Port of the recorder you wish to access.

what to do

get recordS froM a Selected interVal
To acquire Event Record data from an arbitrary interval, perform each of the following steps.

1. Click the list entry of the recorder you wish to access. The entry will be highlighted in blue. Click the 
“Access > Query Selected Interval > Get Data” command. A screen similar to the following will be 
displayed.

Query Selected Interval Dialog Box

2. The four entry boxes allow you to specify any start and end time and any start and end date. Click 
the down arrow on either of the drop‑down list boxes along the right side. A calendar of dates will 
appear as shown in the following. Select the month and then click a date. The box will immediately 
close.
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Calendar of Dates

Make sure that the times and dates reflect the desired interval. The radio button labeled “Direct” 
should be enabled. Click the button labeled “OK”. The following dialog box will be displayed.

Save As Dialog Box

3. In the edit box labeled “File name:” type a descriptive name for the file. The filename can be any 
Windows acceptable name such as “Dundee Incident 09‑11”. The .bin file extension will be added 
automatically. Click the button labeled “Save” to proceed.

As noted in the Save As Dialog Box, the new file will be saved in a sub‑folder named Query. GEA will 
automatically create the Query sub‑folder. It exists within the sub‑folder associated with the selected re‑
corder. Unless you navigate to another location, the Query Selected Interval command will always save 
the data file it creates in the Query sub‑folder.

4. GEA will proceed to establish communications with the selected recorder. Using the assigned 
Password, it will log on. GEA will then issue a series of commands allowing it to retrieve the requested 
data.

5. As shown in the following example, the status bar at the bottom of the GEA window is used to indi‑
cate the progress of the download.
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Status Bar Indicating Successful Retrieval

6. At the completion of the data transfer, the “Dundee Incident 9‑11.bin” file (for the example cited 
herein) will be available for viewing and plotting.

View the Query eVent recordS
The previous exercise will create a highly compressed binary data file. It will be saved in a sub‑folder 
named “Query” The user is unable to view the file directly. However, a GEA command can be used to 
convert it into a readable text document.

1. Click the list entry of the recorder you wish to access. The entry will be highlighted in blue. Click the 
“Access > Query Selected Interval > View Data” command. A screen similar to the following will be 
displayed.

Open File Dialog Box

2. By default the dialog box will always display the contents of the Query sub‑folder. In the sample 
screen previously cited only one Event Record file is shown. Over time, many files will likely be saved 
to the sub‑folder. Select the file you wish to view by clicking its filename. Click the button labeled 
“Open”. A screen similar to the following will be displayed. The following list of Input Names is from the 
Mainline Setup Database.



Metra training guide

106 Micro‑Aide

27

 Query Select Inputs Dialog Box

3. To view records from every input, click the button labeled “OK”. To view records from specific inputs, 
click those inputs in the list. Use the normal Windows techniques of Shift and Ctrl clicking to select 
contiguous and non‑contiguous ranges, respectively. Click the button labeled “OK” when you are 
done selecting inputs.

4. The Event Records will be displayed in an open Notepad file. The document will always be assigned 
a filename taken from the original binary data file. As an example, the “Dundee Incident 9‑11.bin file 
will yield a text file named “Dundee Incident 9‑11.txt”. It too will always be saved in the Query sub‑
folder.

5. The Event Records are always reported using the single‑line record format. Event Record formatting 
and content options are described in Task 13.
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Task 
28

coPy flaSh driVe data

tranSferring flaSh driVe fileS to gea
Task 11 described a procedure for saving Event Record data to a flash drive device. The recorder will 
save files to the USB flash drive in a manner that is completely compatible with GEA. Once the flash drive 
files are copied to the appropriate sub‑folder in your PC, GEA can be used to read and plot the record 
data. This task will describe how the transfer of flash drive files to your PC is performed.

before you Start
You should be familiar with the steps necessary to launch your Windows operating system and log on 
as a user. You should also be familiar with basic Windows operations, such as selecting commands and 
using the mouse. To complete this task GEA must be properly installed on your PC. To follow the example 
cited in this task, your USB flash drive must contain record data from at least one Save operation.

Launch GEA by double‑clicking its desktop icon. Insert the flash drive into any available USB port on your 
PC.

what to do

coPying the fileS
Our objective is to copy files from the flash drive to specific locations within the Main GEA Data Folder. 
The following procedure explains how this is accomplished by using Windows Explorer.

1. Using your mouse, click in the lower left‑hand corner of your desktop in the area labeled “Start”. Then 
click in the area labeled “All Programs”.

2. Click on the folder labeled “Accessories” to expand it.

3. Click the sub‑list item labeled “Windows Explorer”. Click the link, located along the left column of the 
Windows Explorer window, that is labeled “Computer”. This will display the various drives that your PC 
can access.

4. The USB flash drive will be identified as a removable media with a single letter designator of “E:”, “F:”, 
etc. Click its icon or link to reveal its contents. Verify that the flash drive contains a folder named after 
the recorder that was used in the Save operation. In the following example, the folder and recorder 
are named “DIST_SUBDR_XING‑NAME”.
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Windows Explorer – Recorder’s Folder Shown

5. Double‑click on the folder to open its contents. The folder contents will reveal a minimum of three files 
as shown in the following screen. The folder will contain a .txt file and .bin file for each Save operation 
that was performed. A file named “setupdat.bin” will also be included.

Windows Explorer – Recorder’s Files Shown

6. Click the file named “setupdata.bin”. Ctrl‑click the Event Record binary file that was saved. For the 
sample data shown, it is named “09‑11‑11@231223‑100511.bin”. Both files should now be highlighted. 
Right‑click the highlighted files. Select the command labeled “Copy” from the context menu.

7. Using Windows Explorer, navigate to the Main GEA Data Folder. If you have followed the recom‑
mendations in this guide, it will be located on your desktop and named “GEA Recorder Data”. Click 
on the folder to reveal its contents. It may contain several files and folders. However, it will contain a 
folder named after the recorder whose data you have copied. For the example cited, it is named 
“DIST_SUBR_XING‑NAME”.

8. The following screen depicts the contents of a sample recorder sub‑folder.
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Windows Explorer – Recorder Sub‑Folder Contents

9. Move your mouse to a blank area within the right‑side pane of the window and right‑click. From the 
context menu that appears, select the command labeled “Paste”.

10. You have successfully copied the files to the GEA sub‑folder uniquely associated with the re‑
corder that was used to perform the original Save operation. In the example cited herein, 
Windows Explorer will reveal the following folder contents. Note the Event Record data file named 
“09‑11‑11@231223‑100511.bin”.

 Windows Explorer – Sub‑Folder After Paste

helPful tiPS
When copying files from your flash drive to a sub‑folder of the GEA Recorder Data folder, the following 
tips may prove to be helpful.

•	 More than one Event Record binary data file can be copied and pasted at a time. In step 6 simply 
Ctrl‑click additional .bin files saved on the USB flash drive.

•	 Do not copy and paste any .txt files. You can use GEA to read the contents of record and database 
files. Copying .txt files does no harm to GEA, but after time these files may become numerous and 
therefore add possible confusion over the contents of the recorder sub‑folders.

•	 The recorder sub‑folder may already contain a copy of the setupdata.bin file. This was discussed in 
the section entitled “Downloading the Setup Database” on page 94. If it does have the file, there 
is no need to copy it from the USB flash drive. On the other hand, if the file is missing then it must be 
copied.
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View eVent recordS coPied froM the flaSh driVe
This task has explained how to copy flash drive data to appropriate folders that GEA can access. The 
Event Record binary data files can now be translated by GEA into readable text. This can be done as 
previously described in Task 26. Refer to the section entitled “View Event Records” on page 99.
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Task 
29

Plot eVent record data

uSing the Plot window featureS
The three preceding tasks have described how GEA can access Event Record data and how it can be 
read in text form via a .txt document. The Poll Today’s Data, Query Selected Interval and USB file transfer 
features provide GEA with Event Record data that is saved in the recorder’s sub‑folder or its Query folder. 
This task will describe a variety of techniques that can be used to plot your data and then highlight, ana‑
lyze, print and capture the plotted image.

before you Start
You should be familiar with the steps necessary to launch your Windows operating system and log on as 
a user. You should also be familiar with basic Windows operations, such as selecting commands and us‑
ing the mouse. To complete this task GEA must be properly installed on your PC. To follow the examples 
cited in this task, the GEA Recorder Data folder must contain at least one Event Record data file.

Launch GEA by double‑clicking its desktop icon.

what to do

baSic Plotting techniQueS
To plot Event Record data you’ll begin by selecting either of two commands. Both procedures will yield 
identical results. The choice of the initial step is yours. After that, perform each of the succeeding num‑
bered steps to create a basic plotted image. Several GEA features can then be employed to further re‑
fine the content of the Plot Window. Each of these features is described as a separate topic (e.g., Sizing, 
Panning and Zooming).

1. Click the list entry of the recorder you wish to access. The entry will be highlighted in blue. Click the 
“Access > Query Selected Interval > Plot Data” command. Alternatively, click the “View > Plot Event 
Records” command. In either case, an open file dialog box similar to the following will be displayed.

Open File Dialog Box

2. Navigate to and select the file that you wish to plot. Click the button labeled “Open”. The following 
dialog box may open if you have not previously plotted data from this recorder. If it does, click the 



Metra training guide

112 Micro‑Aide

29

button labeled “OK” to plot all of the inputs. If the dialog box does not appear, proceed to the next 
step.

GEA can only plot Event Record data files with a .bin extension. If you wish to plot a file that was saved 
as the result of a Query Selected Interval command, the data file will reside in the Query sub‑folder.

Query Select Inputs Dialog Box

3. The GEA Plot Window will be displayed in its basic form. An example is shown in the following.

Basic Plot Window

The Plot Window will be described in more detail in the following sections. However, you should note that 
it always includes the following properties.

Menu Bar – The Menu Bar is located along the top edge of the window. It includes several commands 
that allow you to control the content and appearance of the window.

Time Scale – Just below the Menu Bar is a time scale that changes automatically as the zoom factor is 
changed.
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Plotting Channels – The Plot Window includes 256 channels, each of which can be assigned a specific 
input to plot. Each plotted input is identified by its assigned Input Identifier (e.g., WAX‑1T).

Scroll Bars – Horizontal and vertical scroll bars are available along the bottom and right side of the Plot 
Window.

Status Bar – At the very bottom of the Plot Window is the Status Bar. The Status Bar is used to provide 
information regarding the Plot Window content when various optional features are used.

The content and appearance of the Plot Window can be controlled by using several different features. 
The basic methods of doing so are described in the following sections. The sample screen entitled “Plot 
Window Showing Different Content and Appearance” on page 115 depicts a Plot Window in which 
several of the following features have been employed.

getting inPut inforMation

Before you alter the content or appearance of the Plot Window it may be helpful to review which inputs 
are assigned to which channels. Information saved in the Setup Database for each input can be easily 
viewed. Position the mouse over the Input Identifier of interest. Right‑click the mouse. From the context 
menu, select the “Details...” command. The following dialog boxes depict information for Digital Input 
D17 and Analog Input A8.

Input Details – Digital Input

Input Details – Analog Input

Selecting inPutS

The Plot Window always includes 256 channels, ordered 1 through 256, top to bottom. However, the 
assignment of inputs to channels is under your control. To change a channel’s presently assigned input, 
position the mouse over the Input Identifier. Right‑click the mouse. From the context menu, select the 
“Select Input(s)...” command. A dialog box similar to the following will be displayed.



Metra training guide

114 Micro‑Aide

29

Query Select Inputs Dialog Box

Click the input you wish to plot. Click the button labeled “OK”. The channel will now plot the input you 
selected. Reassign other channels using the same technique.

A variation of this procedure can be used to change several channel assignments at once. Instead of 
selecting a single input from the dialog box, select several. The additional inputs you select will be as‑
signed to channels in consecutive order. As an example, if you start with channel 12 and select 10 inputs, 
channels 12 through 21 will be reassigned. The new assignments will follow the numerical order of the in‑
puts taken from lowest to highest. Selected inputs do not have to be contiguous. Non‑contiguous inputs 
can be selected by pressing the Ctrl key while clicking the mouse.

MoVing an inPut

Channels are always ordered from top to bottom as 1 to 256. This cannot be changed. Normally, Digital 
Inputs 1 though 64 will be assigned channels 1 through 64. Analog Inputs 1 through 8 follow and they 
are assigned channels 65 though 72. Although not defined by the Metra Setup Databases, the 32 Virtual 
Inputs follow the Analog Inputs. The remaining channels are initially left unassigned.

In some cases it may be helpful to change the top‑to‑bottom order of plotted inputs. To do so, position 
the mouse over the Input Identifier that will be moved. Left‑click the mouse. Without releasing the but‑
ton, drag the mouse vertically to the desired channel location and release the mouse button. The Plot 
Window will be immediately redrawn. Move additional inputs using the same technique.

reMoVing an inPut

You may not wish to plot an input that does not provide useful information for the incident or mainte‑
nance issue you are addressing. In this case, the input should be removed from its presently assigned 
channel. Position the mouse over the Input Identifier that will be removed. Right‑click the mouse. From 
the context menu, select the “Remove” command. The plot of the vacated input will be blank and the 
channel’s assigned Input Identifier will read “(none)”. Remove additional inputs using the same tech‑
nique.

Sizing, Panning and zooMing

Sizing – Like any Windows application, its window size can be changed by dragging any of its four bor‑
ders. It can also be maximized to fill your monitor.

Panning – After you have sized the window to your liking you may wish to pan the view either left or right. 
To do so, click in a blank area of the window and then drag left or right. The plot area near the horizontal 
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location where the initial click occurred will be relocated to the area where you release the mouse but‑
ton. You can also change the view by moving the horizontal and vertical scroll bars.

Zooming – Position the mouse in the area you wish to zoom in or zoom out. Right‑click and select the 
zoom in or zoom out factor you prefer. Zoom factors of 2, 4, 8 and 16 are available. Alternatively, use the 
Menu Bar commands named  “View > Zoom In” and “View > Zoom Out”.

aSSigning a color to a channel

Normally a channel will be plotted in black. To draw attention to a particular input, you may wish to 
change its color. Position the mouse over the Input Identifier whose color will be changed. Right‑click the 
mouse. From the context menu, select the “Color...” command. The following dialog box will be dis‑
played.

Assign Color Dialog Box

Click any color chip followed by the button labeled “OK”. The channel’s entire content will be drawn in 
the newly assigned color. Color additional channels using the same technique.

Plot Window Showing Different Content and Appearance

adVanced Plotting techniQueS
The previous section described the plotting techniques that are most commonly used. Once you be‑
come familiar with their use, you may wish to employ additional techniques that provide even greater 
control of the Plot Window.

SaVing and oPening a Plot teMPlate

In the previous section you learned how to assign, move, remove and color an input. This allowed you to 
reorder the top‑to‑bottom sequence of plotted inputs. The result is a Plot Window suited to your specific 
needs. The template feature allows you to save the Plot Window assignments you created. The saved 
template can then be reused to plot other data according to your preferences. Using this feature, you 
may create several different templates for specialized needs. As an example, one template may be 
used for analyzing approach time issues. Another template may be used to investigate gate up and 
down problems. Yet another may be established as part of a Metra‑defined standard.
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To create a plot template, first create the Plot Window content and appearance you desire. Once this is 
done, click the “File > Save” command. A dialog box similar to the following will be displayed.

Template Save As Dialog Box

Give the template any filename that helps describe its intended use. Save the template in the Main GEA 
Data Folder. Saved templates can be used on any Event Record data that is from a similar recorder. 
For this reason you may not wish to save it in the sub‑folder of a specific recorder. Saved templates must 
include a file extension of .gpl which will be automatically assigned.

To apply a saved template to a basic Plot Window, click the “File > Open” command. Navigate to, select 
and open the .gpl template file you require. The template will immediately redraw the Plot Window in 
accordance with the channel assignments and colors you defined.

Saving and applying templates are illustrated in Figure 14. The upper portion of the figure shows how a 
basic Plot Window has been modified. The result is saved as a template file. The lower part of the figure 
shows how a saved template is applied to a basic Plot Window to modify its content and appearance.

Figure 14: 

Apply a saved template

.gpl file

New content and
appearance

Start with basic plot

.bin file

Save as a templateModify content and
appearance

Start with basic plot

.gpl file.bin file

Saving and Applying a Template
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It is important to remember that saving a template is not the same as saving the record data. The data 
was saved when GEA accessed the recorder and created a .bin record file. The saved template con‑
tains the rules that govern the channel content and appearance. 
 
Templates do not save the pan, scroll position, zoom or cursor settings.

getting eVent record detailS

A plotted input will depict a series of high and low levels. Figure 15 illustrates how events are graphically 
represented as level transitions.

Figure 15: 

On Event Off Event Flashing

How Events are Plotted

Only an Event Record saved to the memory of the recorder will change the level of a plotted input. This 
allows you to view Event Record details at the moment when the level changes. This can be done by 
positioning the mouse within a few pixels of a level transition. Right‑click the mouse. From the context 
menu, select the “Details...” command. A dialog box similar to the following will be displayed.

Event Details Dialog Box

The dialog box will list the Setup Database information for the input. The date and time of the event will 
be listed along with the voltage levels of each Analog Input. Click the button labeled “OK” to close the 
dialog box and return to the Plot Window.

Setting curSorS and Making tiMe MeaSureMentS

The Plot Window can also be used to calculate time differences between events. This feature requires 
that you set two cursors. Set the position of the first cursor by positioning the mouse within a few pixels of 
an event. From the context menu select the “Cursor1 > Set” command. A green vertical line and large 
“X” will mark the position of the first cursor. Set the position of the second cursor by positioning the mouse 
within a few pixels of another event. From the context menu select the “Cursor2 > Set” command. A red 
vertical line and large “X” will mark the position of the second cursor.

From left to right, the Status Bar will indicate the date and time position of both cursors and the time dif‑
ference between them. The fourth field in the Status Bar shows the date and time of the current mouse 
position. As you move the mouse the contents of the field will change.
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To remove a cursor, position the mouse within a few pixels of its vertical line. Right‑click the mouse. From 
the context menu select the “Cursor1 > Clear” or “Cursor2 > Clear” command.

creating eQuation outPutS

Each record data file that GEA acquires includes information for every input during a specific time span. 
A common analysis method is to look at the plotted data for the occurrence of one or more relay states. 
This can be a very time consuming process. The Equation Output feature allows you to define a logical 
association among several inputs and then plot its results. The Equation Output feature will automatically 
sift through all of the data and then plot a result based upon the logical association you defined. This 
can save you a great deal of time and yield an error‑free result.

To define an Equation Output perform the steps listed below.

1. From the Menu Bar of the Plot Window click the “Edit > Edit Equations” command. The following dia‑
log box will be displayed.

Equations Dialog Box – Shown Empty

2. Click anywhere along the row of one of the eight Equation Outputs labeled “EO1” through “EO8”. 
The selected Equation Output will be highlighted in blue. Click the button labeled “Edit”. A dialog box 
similar to the following will be displayed.

Equation Variables Dialog Box – Shown Empty

3. The selected Equation Output can be a function of one to four inputs. To assign an input as a vari‑
able, click any of the four drop‑down list boxes. Select an input from the list. Using the same proce‑
dure assign additional inputs as required. The following screen depicts a typical assignment using 
three inputs.
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 Equation Variables Dialog Box – Typical Example

4. For the example cited, the Equation output will be a function of Digital Inputs D19, D23 and D26. To 
complete the definition click the button labeled “Function...”. A dialog box similar to the following will 
be displayed.

Function Dialog Box – Shown Empty

5. With three assigned variables the sample Equation Output function must include eight distinct states. 
Define the function by first selecting one of the rows. It will be highlighted in blue. Click the button la‑
beled “ON” or “OFF” as required by the definition you are establishing. The following screen highlights 
in blue the states labeled as “ON”.

 Function Dialog Box – Typical Example

6. Close the dialog box named “Function” by clicking its button labeled “OK”. Do the same for the 
dialog box named “Equation”. Finally, complete the Equation Output definition by closing the dialog 
box labeled “Equations”. Click the button labeled “Exit”.
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For the example cited herein, Equation Output EO8 has been defined. An Equation Output can be as‑
signed to any channel. Refer to the procedure described in the section entitled “Selecting Inputs” on 
page 113. Equation Outputs are listed at the very end of the Query Select Inputs dialog box.

Printing the Plot window

The Plot Window can also be printed just as any other document or image is printed. The “File > Print...”, 
“File > Print Preview” and “File > Print Setup...” commands are used in the regular Windows‑defined man‑
ner. The following information may assist you in creating a better hardcopy print‑out.

•	 Select the landscape / portrait setting that yields the best print‑out.

•	 The horizontal dimensions of the print‑out will include all areas of the Plot Window irrespective of the 
horizontal scroll bar’s position. In other words, if the on‑screen Plot Window, is showing 75 % of the hori‑
zontal area, the printed image will include 100% of the horizontal area that can be scrolled.

•	 Additional pages will be printed to accommodate the vertical size of the Plot Window. However, 
channels at the bottom of the Plot Window that are not assigned an input are ignored. Unassigned 
channels in the middle of the Plot Window are printed. Pages are never added to accommodate 
the horizontal dimensions of the Plot Window. The printed image is instead scaled as noted in the 
previous point.

•	 Channels, cursors and equations will be printed in color as they appear on screen, provided a color 
printer is used.

•	 The time scale is printed at the top of each page.

•	 The recorder’s assigned Unit Name is always printed at the bottom of each page.

caPturing and annotating the Plot window

The Plot Window image you have carefully crafted may need to be included in a report to a supervisor 
or manager for further review. GEA includes another feature that can assist you with this requirement.

Once you have the Plot Window content and appearance properly set, click the “Edit > Capture 
Window” command. The Windows Paint application will be launched and the Plot Window image will 
be pasted into a new Paint document. The user can use all of the normal Paint tools to annotate the 
image. The final image can be saved as a .png, .bmp, .jpeg, .gif or .tif file. The saved image can then be 
imported into a document accompanied by descriptions and explanations.

adVanced Plotting exaMPle
Some of the advanced plotting techniques are depicted in the following screen. Both cursors have been 
set at the edges of an Equation Output EO8 pulse. The Status Bar is reporting the cursor dates and times 
as well as the time difference between cursor positions.

Plot Window Showing Cursors and an Equation Output
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Quick Plot feature
If you are involved in the urgent analysis of a crossing incident, it may be that the Quick Plot feature will 
be helpful. With just a few clicks of the mouse you can view plotted data that was recently saved. To use 
this feature perform each of the following steps.

1. In the GEA window, click the list entry of the recorder you wish to access. The entry will be highlighted 
in blue. Click the button located along the left side labeled “Quick Plot”. The following dialog box will 
be displayed.

Quick Plot Dialog Box

2. Select a Plot Template by clicking the button labeled “Browse...”. A dialog box similar to the following 
will be displayed.

Select a Plot Template Dialog Box

3. Navigate to and select the Plot Template you prefer. If a template has not been saved for the 
selected recorder, navigate to the GEA Recorder Data folder and select the PlotAll.gpl template. 
Plot Templates are described in the section entitled “Saving and Opening a Plot Template” on page 
115. Click the button labeled “Open”. The Quick Plot dialog box shown in step 1 will once again be 
displayed.

4. In the drop‑down list box labeled “Hours to Plot”, select a time frame. The setting you select is 
measured backwards from the present time. As an example, if it is presently 10:15 and you select 2 
hours, the plotted data will be from 8:15 through 10:15. Make sure the radio button labeled “Direct” is 
enabled. Click the button labeled “OK”.

5. GEA will proceed to establish communications with the selected recorder. Using the assigned 
Password, it will log on. GEA will then issue a series of commands allowing it to retrieve the data for 
the time frame you specified in step 4.

6. Once GEA acquires the record data you have requested, it will plot it in accordance with the Plot 
Template you selected in step 3. At this point you are free to alter the content and appearance of 
the Plot Window as previously described.

real‑tiMe Plotting
The plotting commands previously described have one thing in common. They plot record data that was 
previously saved by the recorder. The plotted data is historical in nature. However, the Real‑Time Plotting 
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feature can be used to view the status of multiple inputs in real‑time. To plot in real‑time, perform the 
steps listed in the following.

1. In the GEA window, click the list entry of the recorder you wish to access. The entry will be highlighted 
in blue. Click the “Access > Real Time Plot > Direct” command.

2. GEA will proceed to establish communications with the selected recorder. Using the assigned 
Password, it will log on. GEA will then issue a series of commands allowing it to retrieve the real‑time 
status of inputs for up to 50 channels.

The number of plotted channels depends upon the size and resolution of the monitor being used.

3. After a few seconds a blank plot window similar to the following will be displayed.

Real‑Time Plot – Empty

4. The content and appearance of the Real‑Time Plot Window can be controlled as described in the 
following.

•	 The Real‑Time Plot channels can be assigned inputs as described in the section entitled “Selecting 
Inputs” on page 113.
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•	 Color can be added as described in the section entitled “Assigning a Color to a Channel” on page 
115.

•	 The window can be zoomed by right‑clicking in the window and selecting the zoom factor. Zooming 
has the effect of either speeding up or slowing down the speed with which plot advances from right 
to left.

5. A sample Real‑Time Plot is shown in the following. It represents a test pattern of data. Note the simul‑
taneous level transitions that indicate Event Records are being logged to memory. Also, Digital Inputs 
22 and 24 show flashing activity.

Real‑Time Plot Test Pattern
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uSer noteS



MAteriAl return

In the event the customer identifies a malfunction in any product, call or write MICRO‑AIDE and obtain a 
Return Material Authorization (RMA) number from the customer service department. Return the product 
to MICRO‑AIDE, freight prepaid, with a note (in‑warranty repair) or a purchase order (out‑of‑warranty) for 
the repair listing the following information:

•	 RMA number issued by MICRO‑AIDE

•	 Return shipment address

•	 Name and e‑mail address or telephone number of person familiar with the problem

•	 Brief description of the problem (include any printouts that may have a bearing on the problem)

•	 Method of payment for repair costs (out‑of‑warranty)

•	 Send product to the following address:

Micro‑Aide corporAtion 
685 Arrow Grand Circle 

Covina, CA 91722 
Tel: 626‑915‑5502    Fax: 626‑331‑9484 

E‑mail: support@micro‑aide.com

liMited WArrAnty

MICRO‑AIDE warrants its products to be free from defects in material and workmanship for a period of 
five (5) years from the date of shipment. This warranty is in lieu of any other warranty, expressed or im‑
plied. In no event shall MICRO‑AIDE be held liable for incidental or consequential damage resulting from 
(1) the use of any of its products, or (2) any alleged breach of this warranty provision. MICRO‑AIDE’s liabil‑
ity shall be limited to repairing or replacing, at its sole discretion, any defective product which is returned 
in accordance with the MICRO‑AIDE Material Return Policy.

Product that has been subjected to abuse, misuse, alteration, accident, lightning damage, neglect or 
unauthorized installation or repair shall not be covered by this warranty. MICRO‑AIDE reserves the right 
to make a final decision as to the existence of any failures and the cause of such failures. No warranty 
is made with respect to custom equipment or products produced to buyer’s specifications except as 
mutually agreed upon in writing.

mailto:support%40micro-aide.com?subject=Metra%20Support%20Request
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685 Arrow Grand Circle 

Covina, CA 91722 
Tel: 626‑915‑5502    Fax: 626‑331‑9484 

E‑mail: support@micro‑aide.com
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